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CHAPTER 1. KASPERSKY ANTI-

A

VIRUS™ FOR WORKSTATION

Attention! New viruses appear every day, therefore it is
important to keep this product upgraded by updating virus
databases every day (see detailed information below). Please
do not forget to update the anti-virus database upon product
installation!

The Kaspersky Anti-Virus™ for Workstation software package is designed to
protect a computer running the Windows operating system against viruses.

The following software products are included in the package:

Kaspersky Anti-Virus Scanner is an anti-virus program that checks for
viruses and deletes them on demand. The program searches for and
removes viruses from files, boot sectors and RAM. It is able to detect (but
cannot delete!) viruses in archived files and local mailboxes of the most
commonly used mail systems.

Kaspersky Anti-Virus Monitor is a resident virus-detection monitor
that checks files that are started and opened.

Note that Kaspersky Anti-Virus Monitor is able to remove
viruses from ZIP archives!

Kaspersky Anti-Virus Updater is a virus-definition database-updating
utility. When searching for viruses, Kaspersky AV Scanner and Kaspersky
AV Monitor use this anti-virus (or virus-definition) database to identify
viruses detected. Kaspersky Labs updates these databases on a daily
basis by adding new virus details to them; database updates are placed
on Kaspersky Labs web sites and later retrieved by the updating utility.

Kaspersky Anti-Virus Mail Checker is a program that provides anti-virus
security to the Microsoft Outlook 98/2000/XP users.

Kaspersky Anti-Virus Script Checker is a program that protects
computers from script viruses and worms that are executed directly within
computer memory. When you run the Kaspersky Anti-Virus for
Workstation setup utility, the program is automatically added in your
operating system and later you will not have to start it manually.
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Kaspersky Anti-Virus Rescue Disk is a program that allows a user to
create a set of rescue disks to restore the system in the aftermath of a
virus-attack

Kaspersky Anti-Virus Control Centre is a shell program for the software
package components. The Kaspersky AV Control Centre allows a user to
manage installation and updating of the package components, schedule
required operations, launch anti-virus applications and review their
performance statistics.

Kaspersky Anti-Virus Report Viewer is a program allowing a user to
display reports generated by the package components.

The Kaspersky Anti-Virus for Workstation software package allows checking for
viruses on local as well as on network drives. This check can be performed using
Kaspersky Anti-Virus Scanner and/or Kaspersky Anti-Virus Monitor.

By using Kaspersky Administration Kit, the remote administration program, a
network administrator can remotely manage components of the Kaspersky Anti-
Virus software package.

1.1. New features of version 4.5

The Kaspersky Anti-Virus™ for Workstation version described in this book has
the following new features:

Enhanced speed of program operation;
Cleaning ZIP-archives.

An algorithm for checking attachments in both incoming and outgoing
messages has been empowered with the Kaspersky Anti-Virus Mail
Checker utility to minimize computer resources used to check your mail
for viruses.

1.2. Hardware and software

requirements

In order to run Kaspersky Anti-Virus for Workstation you need a system that
meets the following requirements:

Windows 95/98/Me

Intel Pentium processor (or compatible) of 150 MHz or higher.

At least 32 Mb of RAM (64 Mb recommended).
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Windows NT Workstation 4.0 (SP6a or higher):
e Intel Pentium processor (or compatible) of 150 MHz or higher.
e Atleast 48 Mb of RAM (64 Mb recommended).

Windows 2000 Professional:
e Intel Pentium processor (or compatible) of 150 MHz or higher.
o Atleast 64 Mb of RAM (96 Mb recommended).

Windows XP Home Edition/Professional:
¢ Intel Pentium processor (or compatible) of 300 MHz or higher.
e Atleast 128 Mb of RAM.

When running Kaspersky Anti-Virus under the Windows XP Home
Edition or the Windows XP Professional operating system with the Fast
User Switching option selected some features of the anti-virus
program become unavailable: the user cannot change settings of
Kaspersky Anti-Virus and cannot expect the program to interactively
respond to events (for example when Kaspersky Anti-Virus will detect a
virus, it will not display the appropriate dialog box asking a user how to
handle the infected object).

General requirements for all operating systems:

o At least 72 Mb space available on the hard disk to install, and 23 Mb to
run.

e Microsoft Internet Explorer of version 5.5 or higher with SP2.

e No other anti-virus programs installed on your computer, including
Kaspersky Lab products.

& If you have any anti-virus programs installed on your
computer, we recommend that you uninstall them before
installing Kaspersky Anti-Virus for Workstation.

e The monitor resolution should be set to at least 800 x 600, the small font
should be selected, and the system date should be set correctly.

1.3. Distribution kit

You can purchase Kaspersky Anti-Virus for Workstation either from our
distributors (retail box) or online at one of our Internet shops (for example,
www.kaspersky.com - select the Buy online link).
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The retail box includes:

e a sealed envelope with an installation CD containing files for the software
product;

e User Guide;
e alicense key written on the installation CD;
e license agreement.

. Before you unseal the envelope containing the CD, be sure to
thoroughly review the license agreement.

If you buy Kaspersky Anti-Virus for Workstation online, you download the
installation file of the product from the Kaspersky Lab website. This installation
file includes this User Guide and the license key. The license key can also be
sent to you by e-mail after receiving your payment.

The License Agreement (LA) is a legal agreement between you and the
manufacturer (Kaspersky Labs Ltd.) describing the terms on which you may
employ the anti-virus product which you have purchased.

& Make sure you read the License Agreement!

If you do not agree to the terms of this LA, you can return the unused product to
your Kaspersky Anti-Virus dealer for a full refund, making sure the envelope with
the CD is sealed.

If you unsealed the envelope or installed the program, you have agreed to all the
terms of the LA.

1.4. Help desk for registered users

Kaspersky Labs offers a large service package enabling its legal customers to
enjoy all available features of Kaspersky Anti-Virus.

If you register and purchase a subscription you will be provided with the following
services for the period of your subscription:

e new versions of this anti-virus software product provided free of charge;

e phone or e-mail advising on matters related to the installation,
configuration, and operation of this anti-virus product;

e information about new Kaspersky Labs products and about new computer
viruses (for those who subscribe to the Kaspersky Labs newsletter).
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. Kaspersky Labs does not provide information related to operation and
use of your operating system or various other technologies.

1.5. Conventions

In this book we use various conventions to emphasize different meaningful parts
of the documentation. The Table below lists the conventions used in this User
Guide.

Convention Meaning

Bold font Menu titles, commands, window titles,
dialog elements, etc.

Note Additional information, notes
& Critical information
Attention!
@ Actions that must be taken
To do this,
1. Step1.
2. ...
Task or example Formulation of the problem or an example

of how to use the product.

Solution A solution of the problem formulated
[key] — Function of the key. Command line keys
fext of information Text of configuration files, information

messages and the

i messages, and the command line.
command line




CHAPTER 2. INSTALLING AND
UNINSTALLING KASPERSKY
ANTI-VIRUS FOR
WORKSTATION

Before installing Kaspersky Anti-Virus for Workstation make sure to quit
all programs running on your computer.

Launch the setup.exe program on the CD to start the package installation. The
setup wizard operates in dialog mode. Each dialog box contains a certain set of
buttons allowing management of the setup. The main buttons are:

e OK — accept actions

e Cancel — cancel actions

¢ Next — move one step forward

e Back — move one step backward

There are two possible variations on how to install the product: installing it for the
first time and reinstalling. Below, both variants are described in detail.

2.1. Installing

Step 1. Read the license agreement

The License Agreement dialog box contains the agreement text. Read it
carefully and press Yes if you agree to the license agreement terms. Otherwise,
press No to abort the setup.

Step 2. Input user information

Enter user information in the Customer Information dialog box. Enter the
appropriate data in the User Name field and the Company Name field. By
default the information for these fields is taken from the Windows registry.
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Step 3. Select the folder the program will be installed to

In the Choose Destination Location dialog box, select the installation folders
where the Kaspersky Anti-Virus for Workstation program components will be
installed. Destination Folder indicates the folder for the components, and
Common Files Folder indicates the path for files shared by all the components.
To select folders, press Browse and indicate the folder path in the
Choose Folder standard dialog box.

Step 4. Input the program group name in the Start\Programs
menu

Define the folder name in the Select Program Folder dialog box for the
Kaspersky Anti-Virus for Workstation icon to appear in the standard Program
menu. Press Next.

Step 5. Choose setup type
Choose one of the three setup types in the Setup Type dialog box:

Custom You will be asked to select the required components from a
list.
Easy Only the most essential components of the package will be

installed, namely: Kaspersky Anti-Virus Scanner, Kaspersky
Anti-Virus Monitor, anti-virus databases and the updating
program.

Typical All the Kaspersky Anti-Virus software package components
will be installed.

Step 6. Choose the Kaspersky Anti-Virus components to be
installed

If you selected the Custom setup, you will have to choose the required
components in the Select Components dialog box.

To choose the components to be installed check the appropriate boxes at the left
of component names.
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Step 7. Copying files to the hard disk

Read the setup information in the Start Copying Files dialog box. Press Next to
continue the installation. The program will start copying files to the hard disk; the
process is indicated by the progress bar in the Setup Status dialog box.

Step 8. Choose the report storage

In the Report Viewer Settings dialog box, you must define the folder for the
reports generated by Kaspersky Anti-Virus for Workstation components to be
saved to.

Step 9. Define the account under which the Kaspersky Anti-
Virus Monitor service will be started

In the Kaspersky Anti-Virus Monitor Service Properties dialog box, enter
details of the account under which the Kaspersky Anti-Virus Monitor service will
be started.

You can use the following accounts:
¢ Local System account— the Windows account;

e This account — the user account which details are specified in the fields
at the right.

Step 10. Enter the administration password

In the Administration password dialog box, define the password to be used
to remotely access and manage components of the Kaspersky Anti-Virus for
Workstation software package using the Kaspersky Administration Kit
program.

Step 11. Define paths to the key files
In the Key File dialog box, you must define the key file name and path.

If the file is located in the setup folder, its name will be displayed in the List of
key files to install list.

If the key file is located in a different folder, press Add and define the key file
name and path in the Select Key File standard dialog box. If required, the
program may simultaneously use several key files.

The key file is your personal key that contains all the housekeeping data
essential for Kaspersky Anti-Virus to apply all its features:
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e Vendor information for this version (company name, addresses,
telephone numbers)

e Support information (who and where support is provided)
e Product release date

¢ Name and number of the license

¢ Functionality table for various components

e Period of validity for this license

Step 12. To complete setup

Upon completion of the Kaspersky Anti-Virus for Workstation package installation
the Completing Setup Wizard dialog box appears on the screen. Choose one of
the following options:

i Yes, | want to restart my computer now
e No, I will restart my computer later

& In this case, to correctly complete the setup of the Kaspersky Anti-
Virus for Workstation package and start working, it is ESSENTIAL to
restart your computer.

Press Finish.

The startup of your operating system may be delayed because the
program is completing installation of Kaspersky Anti-Virus for

Workstation on your computer. Don’t worry! At this moment Kaspersky

Anti-Virus for Workstation is being registered with your system.

2.2. Reinstalling

If you start to reinstall the program, the Program Maintenance dialog box will
appear on your screen. In this dialog box, you must choose one of the following
options:

¢ Modify — adds new components to the existing installation

e Repair — reinstall all program components (damaged) installed by the
previous setup.

¢ Remove — completely removes the Kaspersky Anti-Virus for Workstation
package from your computer (see subchapter 2.3).

Select one of the options and press Next.
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If you selected the Modify option and pressed Next, the Select Components
dialog box will appear on your screen. Select the required package
components by checking the appropriate boxes in the dialog box and press
Next. The Setup Status and the Completing Setup Wizard dialog boxes
will consequently appear on your screen.

If you selected the Repair option and pressed Next, the Setup Status and the
Completing Setup Wizard dialog boxes will appear on your screen. This
mode can be used if, for example, one of the files included in the Kaspersky
Anti-Virus for Workstation package has been unintentionally deleted.

If Kaspersky AV Control Centre (this or a previous version) has already been
installed on your computer (it could have been installed as a component of
another Kaspersky Lab package), the setup wizard will display the Component:
Kaspersky Anti-Virus Control Centre wizard box. Use this dialog box to define
installation settings of the standard settings file.

In this box, you can select one of the following options:

e Merge — appends a standard settings file to settings detected in the
existing file;

e Overwrite — installs a standard settings file instead of the settings file
detected on your hard drive;

o Skip — keeps the detected settings file unchanged.

If Kaspersky AV Updater has been already installed on your computer, a wizard
box similar to the described above will appear on your screen. However, in this
wizard box the Merge option will not be available. You can use this wizard box to
overwrite or skip the detected settings file of Kaspersky AV Updater.

2.3. Uninstalling

Should you for any reason wish to uninstall the Kaspersky Anti-Virus for
Workstation program, select Remove in the Program Maintenance dialog box
and press Next.

The removal confirmation dialog box will appear on your screen. Press OK to
start the removal procedure. The program files will be removed from the
computer; the process is indicated by the progress bar in the Setup Status
dialog box.

Should the removal program detect files that may be used by other
programs, the file removal confirmation dialog box will appear on your
screen. Press Yes to remove the files.



CHAPTER 3. KASPERSKY ANTI-

VIRUS SCANNER

Kaspersky Anti-Virus Scanner (Kaspersky AV Scanner) is an anti-virus program
that checks for viruses and deletes them on demand.

The

program performs the following functions:

Detects and deletes viruses of all types in files located on user-predefined
disks, in boot sectors and RAM

Detects and deletes viruses from files that have been packed using
PKLITE, LZEXE, DIET, COM2EXE and other compression utilities

Detects viruses (but doesn’t delete) in archived files that have been
archived using one of the commonly used archivers, including ZIP, ARJ,
LHA, RAR, etc.

Detects viruses (but doesn’'t delete) in local mailboxes of the most
commonly used mail systems: Microsoft Outlook, Microsoft Exchange,
Microsoft Internet Mail, Eudora Pro & Lite, Pegasus Mail, Netscape
Navigator Mail, JSMail SMTP/POP3 server.

Detects and deletes viruses from the MS Outlook Express v. 5.0 (and
later) mail databases.

Utilizes an improved heuristic detection tool that is able to search for
unknown viruses (up to 92% effective).

3.1. Starting Kaspersky Anti-Virus

You

Scanner

can start Kaspersky Anti-Virus Scanner from:

Option 1: The Windows main menu. To do this, press the Start button, point to

Programs, point to Kaspersky Anti-Virus and point and click Kaspersky
Anti-Virus Scanner. The program main window will appear on your screen

(see subchapter 3.2.2), and you will see the scanner icon % in the system
tray. Right-click this icon to display the scanner system menu (see
subchapter 3.2.1).



19 Kaspersky Anti-Virus for Workstation

Option 2: Kaspersky AV Control Centre. To do this, you must first create the
appropriate task. This task can be started manually or scheduled to start
automatically.

Option 3: The command line. To do this, you must press the Start button in the
Windows taskbar, point and click Run, define the full path to the file
avp32.exe in the Run dialog box and press the OK button. For example,

C:\Program Files\Kaspersky Lab\Kaspersky Anti-Virus
for Workstation\Avp32.exe.

If you decide to start your anti-virus scanner from the command line, you can use
one of the following available switches:

[/?] or [/H] — displays the complete list of available command line switches;
[/P=filename] — starts Kaspersky AV Scanner with settings from the defined file;

[/S] — sets Kaspersky AV Scanner to check for viruses right after the program is
started;

[/W] — sets Kaspersky AV Scanner to create a report file;

[/N] — minimizes the Kaspersky AV Scanner main window once the program is
started;

[/Q] — sets Kaspersky AV Scanner to close the main window once the scanning
operation is complete;

[/D] — does not launch Kaspersky AV Scanner from being started, if the data
volumes have already been successfully checked that day (that is, if
Kaspersky AV Scanner has already scanned the drives and the operation
was not aborted and no viruses were detected);

[/@[']=filename] — sets Kaspersky AV Scanner to scan for viruses in those files
and/or folders listed in the defined file. The file defined by this switch must
be in common text format (ASCII) and must contain a list of files and/or
folders intended for scanning. Every line of the list should contain only one
file or folder name (with a complete path indicated). If there is the character
"I"in the switch (i.e. /@!=filename), the defined file will be deleted once the
scanning operation is complete. If the character "I" is not used (i.e.
/@=filename), this file won’t be deleted;

[/redundant] — enables the redundant scan tool (for details refer to subchapter
A.2). Redundant scanning is recommended if no virus was detected during
an ordinary scan but the system is still behaving strangely (for example,
there are frequent instances where the computer restarts by itself,
unnaturally slow performance of applications, and so on). Otherwise, we do
not recommend enabling the redundant scan tool as it noticeably slows
down the scanning rate;
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[/virlist=filename] — creates a file with the defined name that will contain the list
of viruses currently detectable by Kaspersky AV Scanner.

[filename and foldername] — sets Kaspersky AV Scanner to scan for viruses in
those files or folders. If a file name or a folder name have spaces, they must
be enclosed in quotation marks. The * or ? symbols cannot be used in file
names, i. e., the *.exe or av?32.exe names cannot be written.

If a folder or a file name with a list of files (/@=file_list.Ist) is indicated
in a command line, scanning starts automatically without the /S key.

[/EL] excludes from the check the objects indicated in the file_name file of the
[/@[!]=filename] parameter.

[/EF] — sets Kaspersky AV Scanner to ignore those files defined in the command
line. The switch /EF can be also used in a file defined by the switch
I@=filename (see above). In this case the object (file or folder) listed
together with the switch /EF will be ignored by Kaspersky AV Scanner. If the
name of the listed file contains spaces, the switch /EF must precede the
filename (the switch can follow the filename, but in this case the filename
must be enclosed with quotation marks). If the name of the listed file doesn’t
contain spaces, the switch /EF can be positioned anywhere in the line.

By using combinations of the switches /EF, /EL, /@ and the list of files
and folders in the command line you can define various locations to be
checked.

Let's consider some examples of switch applications:

Example 1. Starting the program preset to check for viruses in files
within the My documents folder.

C:\Program Files\Kaspersky Lab\Kaspersky Anti-Virus
for Workstation\Avp32.exe" /S "C:\My documents"

Example 2. Starting the program preset to create a list of detectable
viruses in the file E:\virlist.txt and to close the main window once the
scanning operation is complete.

C:\Program Files\Kaspersky Lab\Kaspersky Anti-Virus
for Workstation\Avp32.exe" /virlist=E:\virlist.txt /g

Example 3. Starting the program preset to check for viruses right after it
is started, if Kaspersky AV Scanner has not scanned for viruses that
day or if it has but the scanning operation was aborted or viruses were
detected. The program is also set to close the main window once the
scanning operation is complete.

C:\Program Files\Kaspersky Lab\Kaspersky Anti-Virus
for Workstation\Avp32.exe" /s/d/qg
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Example 4. Starting the program preset to check for viruses in files in
the My documents folder and to ignore the files listed in the file
exclude.txt.

"C:\Program Files\Kaspersky Lab\Kaspersky Anti-Virus
for Workstation\Avp32.exe" "C:\My documents" /EL
/@=C:\exclude.txt

3.2. Program Interface

3.2.1. System menu

When you start the program the main window (see subchapter 3.2.2) appears on

the screen, and the icon is displayed in the system tray; by clicking with your
right mouse button on it you can display the system menu (Figure 1). The system
menu contains the following commands:

o Kaspersky Anti-Virus Scanner Settings — displays the program main
window.

Kazperzky Anti-¥iruz Scanner Settings. ..
Scan Mow

Ealse SEamn

[Ehange Seat Brocess Bt

Show Beport
Update Maw

About K.azpersky Anti-iug Scanner. ..

nload Kaspersky Anti-ins Scanner

Figure 1. System menu

e Scan now / Stop scan — initiates/aborts scanning
e Pause Scan / Resume Scan — pauses/resumes scanning

e Change Scan Process Priority — allows you to change the check priority
(this command is available during the check).

e Show Report — displays the report window with the program performance
results.
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e Update Now - launches Kaspersky AV Updater, the program for
updating anti-virus databases.

e About Kaspersky Anti-Virus Scanner — displays information about the
program.

e Unload Kaspersky Anti-Virus Scanner — unloads the program from
memory.

3.2.2. Main window

In the Kaspersky AV Scanner main window, you can change scanning settings,
start/stop scanning and review the program performance results. You can exit
the main window without unloading the program from memory.

The following items are located in the Kaspersky AV Scanner main window:
menu bar, tool bar, work area, and status bar. Below, these items are described
in detail.

3.2.3. Menu

The menu bar is located at the top of the main window. Some menu commands
can be also activated using appropriate key combinations or buttons in the tool
bar (see subchapter 3.2.4). The appropriate key combinations are displayed at
the left of the menu commands. For details of the matching functions of key
combinations, tool bar buttons and menu commands, see subchapter 3.2.4.

Menu > commands Function (The command allows you to...)

File > Open Profile load settings from the current profile (see
subchapter 3.3.4).

File > Save Profile save current settings to the current profile
(see subchapter 3.3.4).

File > Save Profile As save current settings to an alternative profile
(see subchapter 3.3.4).

File > Save Profile as Default | set the current settings as the default (see
subchapter 3.3.4).

File > Recent Profiles select the profile from a list of files recently
used.
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Menu = commands

Function (The command allows you to...)

File > Unload
Anti-Virus Scanner

Kaspersky

unload the Kaspersky AV Scanner program
from memory.

File > Close window

exit the program main window.

Scan - Start Now / Stop scan

start/ stop scanning for viruses

subchapter 3.4.1).

(see

Scan - Pause Scan /
Resume Scan

suspend / resume scanning for viruses (see
subchapter 3.4.1).

Scan > Change Scan

Process Priority

change the active scanning process priority
(this item is available only during the
scanning process — see subchapter 3.4.2).

Scan = View Scan Options

display the program settings in plain text
form (see subchapter 3.3.5).

Tools - Update Now update anti-virus databases (see
subchapter 3.5).
Tools = Show Report display the report window (see

subchapter 3.4.3).

Tools = Make Virus List

generate a list of currently known viruses
(see subchapter 3.6).

Help > Contents

display the Help topics window.

Help - Kaspersky Anti-Virus
on the Web

start your web browser and go to the
Kaspersky Labs site.

Help > About Kaspersky Anti-
Virus Scanner

display information about the program.

3.2.4. Tool bar

Buttons are located in the tool
commands.

bar. By pressing them you can initiate various
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Button Menu > Command

Function (The button allows you
to...)

File > Open Profile

load settings from the
profile.

required

File > Save Profile

save current settings to a profile.

File >
Save Profile as Default

save current settings to a file and
set this file as the default profile.

Scan - Start Now

start scanning for viruses.

Scan > Pause Scan/
Resume Scan

suspend/resume scanning.

Scan - Stop scan

stop scanning for viruses.

Scan > View Scan

Options

display settings in plain text form.

Tools > Show Report

display the report window

Tools - Update Now

update Anti-Virus bases.

File > Unload Kaspersky
Anti-Virus Scanner

we® BE =+ 88 W

unload the Kaspersky AV Scanner
program from memory.

3.2.5. Work area

The main window work area is divided into two frames. The left frame contains
icons with the following names: Objects, Options, Customize and Statistics.
The right frame displays the settings corresponding to the left-frame icon that is

currently pressed.

The Objects frame allows you to define a location to be checked (the list of
drives and folders), objects to be checked (e.g. sectors, files, mail databases),
and rules to be followed while handling infected objects (see subchapter 3.3.1).
All these settings are arranged into a special control element, the objects settings

hierarchy.
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The Options frame allows you to define certain general settings, and you may
use a settings tree in the Customize frame to define advanced settings of your
Kaspersky AV Scanner (see subchapters 3.3.2, 3.3.3).

The Statistic frame displays a table with the scanner performance statistics (see
subchapter 3.4.4).

Each item of the settings tree has a right-click menu with commands applicable
to the item.

@ To display the right-click menu of an item in the settings tree,

1. Place your mouse cursor on the required item.

2. Click your right mouse button. The appropriate right-click menu will
appear on your screen (Figure 2).

=

RGN “s= Expand

[ [ Recyler E Uncheck
~[ (3 Sabramoy T
B serger [ SetStict
3 Temp B Lpplviparente optiots
w-fF (3 Utils e Chieck ChildEen
-4 E Wi B Wncheck Chidrer
i Lal LR R

Figure 2. An example of the right-click menu

3.2.6. Status bar

At the bottom of the Kaspersky AV Scanner main window you can find a status
bar. The status bar displays the following information:

e context-sensitive prompts / name of the examined object;

e indicator of the scanning progress.

3.3. Changing Settings

In this subchapter we describe how to customize all scanning parameters used
by Kaspersky AV Scanner.
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3.3.1. Scanning parameters for objects.
Objects category

The Objects frame (Figure 3) in the work area allows you to choose locations
and objects to be checked for viruses. You may do this by selecting appropriate
options in the frame hierarchies. These options may be viewed in the following
two modes: Standard and Expert. To switch between these modes use the
corresponding buttons in the left frame of the window work area.

ﬁKaspelsky Anti-Virus Scanner
File Scan Taols Help

FEM [ R[TH - KAfPzR{ICY 2
Standard =0 My Computer - Actions in case of ving detection

=-[J = 37 Floppy [:)

Expert

) Rename object

O Delete object

Scan files of following types

Sican seclors

Scan compound files of the fallawing ty|
Enable code analpser

O =& D
-1 B 03pmedl ()

< || KD | B
Narme | Size | Type | Madified ‘ -
O utoe... 0 M5-D0OS BatchFile  2415/01 12:07:00 PM

O baootini 288 Configuration Seti...  2/15/01 35248 &M

O Confi.. 0 System file 2/15¢01 12:07:00 PM s
O lo.sps 0 Sestem file 2415401 12:07.00 PM

O Msda... 0 Sestem file 2415401 12:07.00 PM

| o Wl [T el ME-NNS &rnlicabinn 21501 94915 AWM LI

Anti-virus bases are loaded. Known viruses: 48378, [ /_,l

Figure 3. The Objects frame

With the Standard mode enabled the Objects frame is divided into two sub-
frames: in the left sub-frame you may see the list of computer disks, and the right
sub-frame displays settings for the item selected in the left sub-frame list

(Figure 4).

== by Cormputes
O =2 37Floppy &) O Scan files of following types

= IC) Scan sectors

e Scan compound files of the following types

-0 @ 09prmed (E:) Enable code analyser

Figure 4. The Standard view mode
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With the Expert mode enabled, the Objects frame is divided into three sub-
frames: in the upper left sub-frame you can find the file system hierarchy, the
upper right sub-frame displays settings for the item selected in the upper left sub-
frame hierarchy, and the lower sub-frame displays the list of files located in the
root of the object selected in the upper left sub-frame (Figure 5).

B- . =)ty Computer B Actiong in case of virus detection
|:| = 37 Floppy 14 e B) sk uzer
= {5 i () Report anly
D 25 [0 - ) Disinfect
=-O @ 09prrncddl (E:) ------ ) Rename object
fee (3 Delete objsct
H- [ Scan files of fallowing twpes
------ Scan sectors
[ Scan compound files of the following b
------ Enable code analyzer
1] | »ljed |
Mame | Sizel Tupe | Modified | -
a .-’-‘«utoe:-tec.... 0 MS-DOS Batch File 215/01 12:07:00 P
O bt ini 288 Configuration Settings  2/15/071 9:52:48 Ak
O Config.gyz 0 Syztem file 2/5/01 120700 P —
a lo.sys 0 Spstem file 215/01 12:07:00 P
O Madog syz 0 System file 2501 12:07:00 P
| I i T YT L b n s = ¥ [= T L= L L e B h W = e ML O, Lo TR =X X | 7

Figure 5. The Expert view mode

Use the upper left sub-frame to define the location that must be checked for
viruses. Check a box I to define the corresponding object to be checked. If you
uncheck the box [, the corresponding object will be skipped during the check.

To scan a certain location within the file system, check the corresponding box to
the left of the location name.

To scan a group of disks, check the My Computer box in the upper left sub-
frame and the required boxes in the upper right hierarchy:

Scan local removable disk drives — scans all removable disks. This check
box is available only if you checked the My Computer box in the upper left
sub-frame. If this box is checked, the program will scan all removable drives.

Scan local hard disk drives — scans all local hard disks. This check box is
available only if you checked the My Computer box in the upper left sub-
frame. If this box is checked, the program will scan all local hard disks.

Scan network drives — scans all available network disks. This check box is
available only if you checked the My Computer box in the (upper) left sub-
frame. For the same results you may check boxes of all available network
disks in the (upper) left sub-frame.
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If you select the option to scan a certain location within your file system,
Kaspersky AV Scanner will automatically scan all the locations within the
selected one. However, when in the Expert view mode you can mark the
required sub-locations to be excluded from the check.

=B S My computer For example, you defined the disks
: =4 S C: and D: to be checked for
g g\,@’;s'&%g ) viruses, but you do want the
..... (3 Adoheapp D:\public\archives directory to be

- ([0 DISTRIBUTIVES excluded from the location defined

3
= (3 for public to be checked. In this case you
; & privete must check the C: and D: boxes,
and then, in the hierarchy for the D:
disk, uncheck the archives box.

3 Information
[ Recycled

BB (3 self

B[ 3 warking

-0 % Audio CD (E)

If you excluded a folder from the location to be checked, a triangle will appear in
the checked boxes of all the parent locations: H instead of E. If you excluded a
certain location from the larger location that is defined to be checked for viruses,
the scanner will not check it at all or will not check it using the rules defined for
the parent location. You may eliminate (disable) this difference inside the larger
location, or keep it for a certain period of time. For details refer to subchapter 8.3.

For every defined location within your file system you can specify separate
scanning settings. For every defined location to be checked you can also specify
the objects to be checked by using the settings tree in the right hand pane.

3.3.1.1. Defining objects to be checked. Memory,
sectors, and files

For locations that correspond to different levels of the file-system hierarchy the
upper right frame displays different groups of settings. The maximum quantity of
settings is displayed for the My Computer location. Here you can set your
scanner to check your computer memory, boot sectors, groups of disks and MS
Outlook Express (v. 5.0 and later) databases. When defining settings for a disk
you can enable the check of boot sectors and file systems located on this disk.
For a folder you cannot disable the check of file system. You can, however,
define how the scanner must process infected and suspicious objects, in what
type of files it must check for viruses and enable/disable the advanced scanning
modes for all the locations in the upper left frame.
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Scan files of following types — scans files in the corresponding locations
(including System, Hidden and Read Only files). This check box is available
if you checked the My Computer or a disk box in the upper left sub-frame.
You cannot uncheck it for a folder or file. If you check this box you must
define file types to be checked for viruses:

&  All infectable — scans all files that are able to carry a virus.
@&  All — scans every file of every type.

& By mask — scans the file types defined by user in the text fields below.
You can specify an unlimited quantity of file types, but make sure that
one text field contains only one file type.

Exclude by mask — excludes from the check the file types defined by
user in the text fields below. You can specify an unlimited quantity of file
types, but make sure that one text field contains only one file type.

Scan sectors — scans boot sectors (master boot record and boot sectors).
This check box is available only if you checked the My Computer or a disk
box in the upper left sub-frame.

Scan memory — scans RAM. This check box is available only if you
checked the My Computer box in the upper left sub-frame.

Scan MS Outlook Express databases — scans MS Outlook Express (v. 5.0
and later) databases. This check box is available only if you checked the My
Computer box in the upper left sub-frame. For details of scanning in mail
databases of the other formats see subchapter 3.3.1.3.3.

Kaspersky Anti-Virus Scanner checks only in those *.dbx files that are

stored within the MS Outlook Express working directory and,
respectively, started every time you start MS Outlook Express. The
*.dbx files in other directories are considered by the program as
standard mail databases. The program is able to detect viruses in those
databases but cannot delete them.

Scan start-up objects — scans objects started at the operating system start.
This check box is available only if you checked the My Computer box in the
upper left sub-frame.

3.3.1.2. Handling infected and suspicious objects

detected, the program will perform one of the following actions:

@ Ask user— Kaspersky AV Scanner will open up the dialog box
(Figure 6). This dialog box contains the name of the infected file, the
name of the detected virus and a list of possible actions to be performed
with the infected object (that is, a list of all possible actions except for
& Ask user). In addition, the dialog box contains the Apply to all
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infected objects check box; by checking this box, you can apply the
selected action to all infected objects detected later, and which you
previously predefined to be handled by opening the dialogue box. Upon
detection of the next infected object, the dialog box will not appear
again. The following three buttons are located at the bottom of this
dialog box: OK (accepts the selected action), Cancel (closes the dialog
box and proceeds with scanning) and Stop (stops scanning for viruses).

& Report only — the program will only report the infected and suspicious
objects. The report can be viewed by starting the report viewer,
Kaspersky Report Viewer (see Chapter 7).

& Disinfect — the program will try to cure all infected objects without
asking first. As a result, the detected viruses will be removed, and the
object will be restored as an operable one.

Make backup file before disinfection — to create a copy of the
infected object before starting a cure. A directory where the copy
will be created is specified in the settings tree of the Options
category (see subchapter 3.3.2.2). The copy will not be deleted
upon completion of treatment.

=---If disinfection is impossible — not all infected objects can be
cured, because some viruses damage computer data irreversibly.
In this case, Kaspersky AV Scanner can operate using one of the
following three methods: @ Report only — informs you about
unsuccessful attempts at treatment, ® Rename object — renames
the unrecoverable file, & Delete object — deletes the damaged file.

©® Rename object — the program will rename all infected objects. The
renaming rules are specified in the settings tree of the Options
category (see subchapter 3.3.2.2).

e Delete object — the program will delete all infected objects without
warning.

The Delete object and the Rename object options are applied to

compound infected files only if you checked the Enable delete or rename

non-disinfected compound files box on the Options page. If the box is

not checked the program will not delete or rename compound files.
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Figure 6. The Ask user dialog box

3.3.1.3. Advanced scanning modes

3.3.1.3.1. Scanning compound objects

You can enable advanced scanning modes to check for viruses in archives,
packed files, mail databases and plain mail formats (for details see Appendix A).

= Scan compound files of the following types — check this box to process
compound objects as folders containing a set of objects.

Sometimes the program is able to detect a virus in a compound file (archive, mail
database, plain mail file) but cannot remove it from the file. Therefore when you
run the program with the Delete objects or Rename object option button
selected its advisable that you check the Scan compound files of the
following types box and uncheck the Enable delete or rename non-
disinfected compound files box on the Options page. In this case, if there was
detected an infected compound file, the program will log this event but the file will
not be deleted or renamed. Later on you will be able to extract the object, check
it with your anti-virus program and delete the virus from extracted files.

If you check the [ Enable delete or rename non-disinfected
compound files check box, you can lose important data.

3.3.1.3.2. Scanning archives and self-extracting files

Scanning archives for viruses is an extremely important task because a virus can
be stored in an archived file for several months or even years, causing no harm
to your computer. However, if activated, this virus can cause serious problems.
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Archives — check this box to search for viruses in files archived using
ZIP, ARJ, LHA, RAR, CAB and some other archiving utilities.

Kaspersky Anti-Virus is able only to detect viruses from archives. In
addition, Kaspersky Anti-Virus does not extract password-protected
archives.

Archives with self-extractors — check this box to search for viruses in
self-extracting archives, i.e. executable files that can be started to
extract the archived files. Some self-extracting archives also
immediately start one of the extracted files.

The extracting tool is able to correctly extract files that have been compressed
multiple times. It can also deal with some versions of immunizers, programs
protecting executable files from viruses by attaching checking code blocks
(CPAV and F-XLOCK) and enciphering programs (CryptCOM) to them.

3.3.1.3.3. Scanning mail databases and plain mail

files

The program is able to search for viruses in mail databases and plain mail files.

Mail databases — check this box to search for viruses in mail databases
of the following formats:

e  Microsoft Outlook, Microsoft Exchange (the .pst and the .pab
extension files, the MS Mail archive type);

e  Microsoft Internet Mail (the .mbx extension files, the MS
Internet Mail archive type).

e Eudora Pro & Lite;

e Pegasus Mail;

e Netscape Navigator Mail;

e JSMail SMTP/POP3 server (user database).

If the mail database scan mode is enabled, the program checks every
entry in mail databases and scans attached files. The following formats
are supported: UUEncode; XXEncode; btoa (up to 5.0); btoa 5.%;
BinHex 4.0; ship; NETRUN 3.10; NETSEND 1.0 (not packed);
NETSEND 1.0C (packed); MIME base 64.

Plain mail — check this box to search for viruses in plain mail files of the
formats Eudora Pro & Lite, Pegasus Mail, Netscape Navigator Mail,
JSMail, and user databases on SMTP/POP3 servers.
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If the plain mail check mode is enabled, Kaspersky Anti-Virus checks
every file for a message header. If a message header is detected, the
program searches for attached data (UUEncode, XXEncode and etc.)
and checks it for viruses.

The mail database and plain mail modes noticeably slow down the Kaspersky AV
Scanner scanning rate. For that reason we do not recommend their use in
regular virus checks.

& Kaspersky AV Scanner is not able to delete viruses from mail
databases and plain mail files, it is able only to detect them. However, if
you check the B Scan MS Outlook Express databases box, the
program will be enabled to detect and delete viruses from MS Outlook
Express (5.0 and later) databases.

3.3.1.3.4. Scanning embedded objects

The program allows you to check for viruses not only in files, but also in the
objects embedded in these files using the OLE technology. Check the
Embedded objects box to search for viruses in OLE objects embedded in the
examined files.

3.3.1.3.5. Heuristic detecting module

You can enable the built-in heuristic detection module to scan for viruses that are
unknown to the program (not described in current anti-virus databases). Check
the Enable Code Analyzer box to scan for viruses using the heuristic
detecting module.

3.3.2. General settings: Options

The Options frame (Figure 7) contains options allowing you to choose how the
scanner should report performance statistics and rename the infected files it
detected. Here you can also set the scanning priority.
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Figure 7. The Options frame

N

3.3.2.1. Reporting options

= 4 Save report file — check this box to save the report to a file. If you check
this box, you will be able to monitor the performance of Kaspersky AV
Scanner using Kaspersky Report Viewer (see Chapter 7). When displaying
the performance results, this program will use settings defined in the
Save report file branch.

k=l Report file name — use this field to define the report file name

By default the report file is created in the directory that you specified
during program installation. If the program operates independently of
Kaspersky AV Control Centre, you can re-define this directory by
specifying the full path to your report file. If the program is controlled by
Kaspersky AV Control Centre, you cannot re-define this directory.

Show pack info in the report— check this box to receive reports about
packed and archived objects. These messages have the following
format in the Kaspersky Report Viewer table: the Object column shows
the object name, the Result column shows the Packed or Archive
strings and the Description column shows the name of the
corresponding compressing or archiving utility.

Show clean object info in the report — check this box receive reports
about virus free objects. These messages have the following format in
the Kaspersky Report Viewer table: the Object column shows the
object name, the Result column shows the OK string.
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Append — check this box to append new reports to the existing report
file. This is useful if you want to keep reports on several or all the
previous checks. If the box is not checked, every time Kaspersky AV
Scanner is started it will create a new report file.

Limit size to (Kb) — check this box to limit the size of the report file to
the value specified in the field below. The default value is 2048 Kb.

3.3.2.2. Renaming, copying, and deleting options

allow you to choose between moving infected objects to a special folder and
renaming them. The program will apply this setting to those objects, for
which you selected the Rename object option in the Objects settings tree
(see subchapter 3.3.1).

@ Special folder — this option button moves infected objects to a special
directory defined in the text field below. In this case, infected objects are
moved to the folder with their names and extensions unchanged.

& The object folder — this option button renames infected objects, i.e.
changes their extensions to the one defined in the Extension of
infected file field.

Enable delete or rename non-disinfected compound files — check this
box to allow the program to delete or rename infected archives. This check
box is used only for those compound objects for which you selected the
Delete object or the Rename object options (respectively) in the Objects
settings tree. It is not advisable to check this box, since you may lose the
data that cannot be recovered without some type of recovery software.

3.3.2.3. Defining priority

El' Assign the scan process priority to — allows you to define the priority of

the check. You can select one of the following three values: High — the
operating system will transfer CPU control to your Kaspersky AV Scanner
more frequently and for longer periods than to other applications; Normal —
the CPU will pass control to your Kaspersky AV Scanner as frequently as to
other applications; Low — the CPU control is transferred to your Kaspersky
AV Scanner less frequently and for shorter runs than to other applications.

3.3.3. Advanced settings: Cusfomize

The Customize frame (Figure 8) contains option allowing you to define
advanced settings of the program.
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=-BEl  Use sound effects for the following events — check this box to play
sounds when checking for and deleting viruses.

k=l Infected object found— allows you to set the sound file that is played
each time an infected object is detected. While selecting files in the
corresponding window you can use the Test button to listen to them.

k=l Scan process finished— allows you to set the sound file that is played
when the check is finished. While selecting files in the corresponding
window you can use the Test button to listen to them.

Bl Pop-up Scanner window after scan finishes — check this box to display
the program main window with the Kaspersky AV Scanner performance
statistics right after the check is finished. If your Kaspersky AV Scanner
main window is closed and you started scanning for viruses from the system
menu, the main window will appear on your screen right after the check is
finished.

Bl switch to "Statistic" tab after scan starts — check this box to switch to the
Statistic frame right after Kaspersky AV Scanner starts checking for viruses.

B switch to "Statistic" tab after scan finishes — check this box to switch to
the Statistic frame right after Kaspersky AV Scanner finishes checking for
viruses.

EKaspelsky Anti-Yirugs Scanner

File Scan Tool: Help

SHME > R[EH| KAJPzRIKY £

Standard

Expert

Scan process finished <Finish. wavs

Pop-up Scanner window after scan finishes

O Switch ta "Statistic” tab after scan starts

Switch to "Statistic” tab after scan finishes

Prampt nest disk insertion for removable drives
Display attention messages

Check new updates

H Check interval [days) <14

Antivirug bases are loaded. Known viuses: 48978, /él

Figure 8. The Customize frame

El Prompt next disk insertion for removable drives — check this box to set
the program to prompt for the next removable disk. In this case Kaspersky
AV Scanner will scan for viruses on the removable drive you offered and,
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when finished, will ask for the next removable drive. This setting is used if
you preset Kaspersky AV Scanner to scan data only on the removable drive.

B Display attention messages — check this box to display other warning
messages.

=B  Check new updates — check this box to automatically start the anti-
virus database-updating program on a regular basis. In the Check interval
(days) dialog box, set the required interval between two automatic starts
(the dialog box is displayed right after you check this box).

If you are working with program settings from Kaspersky AV Control
Centre you will not find some of the Customize settings listed above.
These settings make no sense if you are using Kaspersky AV Control
Centre.

3.3.4. Saving/loading settings

If you frequently set your Kaspersky AV Scanner a certain way, you may save
these settings to a file. These settings will be stored there and if you need to set
the Kaspersky AV Scanner the same way later, you can simply load them from
this file. Files with Kaspersky AV Scanner settings are called scanner profiles.
For example, you may want create a profile with settings allowing you to check
for viruses in several diskettes one after another, or you may wish to create a
separate profile with settings allowing you to thoroughly check for viruses in all
the files on your computer, etc.

You can also set one profile to be loaded by default. Each time you start your
Kaspersky AV Scanner it will load settings from this profile.

Main Menu Toolbar Key
combination
To load settings | File > Open Profile = <CTRL>+<0>
from a profile
To save settings | File > Save Profile, File n <CTRL>+<S>
to afile - Save Profile As

To define the | File > Save Profile as
profle to be | Default E
loaded by default

By default, Kaspersky AV Scanner profiles have the .klr extension.
If no profile is set to be loaded by default, Kaspersky AV Scanner will
use the default settings defined in the program code.
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3.3.5. Previewing settings before the check

You can review your scanner settings in text form. The text describes rules
specified for all the objects of your file system: from My Computer to separate
files. For example, if the rules that your Kaspersky AV Scanner uses to check
and process the autoexec.bat file differ from those used for the parent object -
System disk (C:), a list of these rules will be displayed separately.

To review the text describing your Kaspersky AV Scanner settings, select the
View Scan Options command from the File menu or click the toolbar button

R

The Scan Options windows containing values of the Objects and Options
settings will appear on your screen (Figure 9). You can view and copy the setting
values. When you finished working with this window click OK.

. Scanner settings in text form are also written at the beginning of your
report file.

1 Scan Dptions [_ O] |

-

Save report file = Yes

Feport file name = avp32.pt

Show pack info in the report = Mo

Show clean obiect info in the repart = Ma

Append = No

Limit gize ta [kB] = Yes

Limit size = 2048

For renaming of infected objects use = Special folder
Folder name = Infected

Use quarantine = res

Enable delete ar rename not-disinfected archives = Mo
Azsigh the scan process prionity to = Normal

"My Computer"
Enable processing = Yes =
K7 LI_I

Figure 9. The Customize frame



39 Kaspersky Anti-Virus for Workstation

3.4. Checking for and deleting
viruses

3.4.1. Starting and aborting the check

Scanning for viruses can be initiated/terminated automatically via Kaspersky AV
Control Centre, or on demand from both Kaspersky AV Control Centre, and the
Kaspersky AV Scanner main window.

When Kaspersky AV Scanner starts checking for viruses, you can
suspend/resume the scanning process, change the process priority or stop
scanning.

Main menu System menu Toolbar
Starting Scan - Start Now Start Now ﬂ
Aborting Scan - Stop scan Stop Scan ﬂ
Pausing Scan - Pause Scan Pause Scan ﬂ
Resuming Scan - Resume Scan Resume Scan ﬂ

Let's review the operations performed by Kaspersky Anti-Virus Scanner right
after it is started. First, the program loads anti-virus databases and checks itself
for viruses. If the program is successfully loaded, the following string appears at
the bottom of the program main window:

Antiviral bases were loaded. Known viruses: XXXX

where XXXX is the number of viruses described in the anti-virus bases. If the
program is infected, it will try to disinfect itself. If the virus was successfully
deleted the program will be restarted and you will see a message that all the
viruses have been deleted. If the program fails to disinfect itself, it will not be
started and the corresponding information window will appear on your screen. If
you have the virus-free distribution copy of Kaspersky Anti-Virus, delete the
infected program and reinstall Kaspersky Anti-Virus on your computer.

When finished checking for viruses, Kaspersky AV Scanner generates
appropriate exit codes that can be used to create batch files. The
program can return one of the following values:
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e 0 -noviruses detected:;

e 1 - scanning was interrupted;

e 2 - detected objects contain a modified or damaged virus;
e 3 —objects suspected of being viruses were detected;

e 4 —one or more viruses were detected;

e 5 -—allinfected objects are disinfected;

e 7 —Kaspersky AV Scanner is corrupted;

e 10 —Kaspersky AV Scanner internal error.

3.4.2. Changing priority of the check

@ You may change the priority of the check without aborting it. To do this,
follow these steps:

1. Select the Change Scan Process Priority command from the
Scan menu.

2. Select the required value (for more detail, see
subchapter 3.3.2.3) from the drop-down list in the dialog box
that appears on your screen (Figure 10).

Kaspersky Anti-¥irus Scanner %]

Assign the scan process prionity, which is uzed by the system
to zchedule the running of processes.

TR -

Indicates a process which runs only when the spatem is idle
and iz preempted by any process running at a higher prionity.

ak. I Cancel Help

Figure 10. The scan priority dialog box

& When the check is in progress you cannot change other settings! If you
want to change other settings, first you must abort the check, then
change settings and restart the check again.
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3.4.3. Monitoring progress

If you enabled Kaspersky AV Scanner to report on its performance (see
subchapter 3.3.2.1), you can use the Kaspersky Report Viewer program to
monitor the performance in progress. To start the program, select the Show

report command from the Tools menu, or click the toolbar button . The
Kaspersky Report Viewer main window allowing you to monitor your Kaspersky
AV Scanner progress will appear on your screen (see Chapter 7).

3.4.4. Viewing statistics: Stafistics

If you enabled Kaspersky AV Scanner to report on its performance you can view
the performance statistics in progress in the Statistics frame (Figure 11).

&Ka:pelsky Anti-Virug Scanner
File Scan Tool: Help

S e [R[EH KAJPZRYKY 2

Standard ‘ | =
Thursday, October 11, 2001 5:06:53 P Kaspersky Antidinuzs Scanner : started

Expert

Scanned:

Sectors
Files

Folders
Archives
Packed files

PPN P

Found:

Known vinses
Wiruz bodies
Disinfected
Deleted
Fienamed

W arhings
Suspicious
Corrupted

140 Emors

ocoooocoooo

Scan speed [Kb/sec) 39 ;I

Ready [ /ﬂ

Figure 11. The Statistics frame

The frame table is divided into the following two sections: Scanned and Found.
The Scanned section displays numbers of checked sectors, files, folders,
archives and compressed files. The Found section displays the numbers of:

e viruses detected;

e virus bodies (that is, the number of files infected by a known virus);
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o disinfected objects (that is, the number of objects from which viruses were
correctly deleted);

e deleted objects;
e renamed objects;

e warnings, i.e. messages about objects containing codes similar to known
virus modifications;

e suspicious objects (that is, Code Analyzer notifications);
e corrupted objects;
e 1/O errors.

At the bottom of the frame you can see the scan speed (Kb per second) and the
time that your scanner spent checking for viruses in all the objects.

3.5. Updating Anti-Virus databases

You can start the anti-virus database-updating program from your Kaspersky AV
Scanner main window. To do so, select the Update now command from the

Tools menu or click the toolbar button ﬁ

3.6. Generating a list of currently
known viruses

@ You can generate and review the list of currently known computer
viruses. To do this, follow these steps:

1. Select the Make Virus List command from the Tools menu. This
command starts Kaspersky Virus List Generator.

2. In the Kaspersky Virus List Generator dialog box (Figure 12) on
your screen, define the file name for the list to be saved to. To do
this, use the Browse button.

3. Press the Generate button.
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%g Kaspersky Yirus List Generator [_ o] =]

Wius list file name:

|E:\PHEIGHA”1 SCOMMON™THEAY SHA™ o/ List vl Browse... |

Show fist |

Figure 12. The Kaspersky Virus List Generator dialog box

To display the list, press the Show list button. This button starts Report Viewer,
which can be used to review the generated list of viruses.

To exit the Kaspersky Virus List Generator dialog box press the Exit button.

You can start Kaspersky Virus List Generator directly from the Windows main
menu. To do this, press the Start button in the left bottom corner of your
Windows screen, point to Programs, point to Kaspersky Anti-Virus and click
the Kaspersky Virus List Generator command.



CHAPTER 4. KASPERSKY ANTI-
VIRUS MONITOR

Kaspersky Anti-Virus Monitor (Kaspersky AV Monitor) is a memory-resident
program that monitors files when they are accessed. Whenever somebody refers
to an object, the monitor checks the object to make sure that it is free of viruses.
If the object is found to be infected, the program will attempt to disinfect the
object, delete it, move it to a quarantine folder or allow it to be accessed,
depending on the options that were selected. In this way the anti-virus monitor
allows you to detect and delete viruses before the system is actually infected.

Here we must note that there is more than one term describing programs similar
to the Kaspersky Labs Anti-Virus Monitor. For example, they are sometimes
called resident scanners, anti-virus filters, on-access scanners, etc.

4.1. How to start, disable and enable
your AV Monitor

There are several ways to start your anti-virus monitor. Your Kaspersky AV
monitor can be started:

Option 1: From the Windows Start menu. To do this, click the Start button on
your Windows desktop, point to Programs, point to Kaspersky Anti-Virus,

then click the Kaspersky AV Monitor command. The monitor icon D will
appear in the system tray. Click this icon with your right mouse button to
display the monitor system menu (see subchapter 4.2.1).

Option 2: Automatically. The Kaspersky AV Monitor can be loaded automatically
when you start your computer if you add the program to the Startup folder of
the Windows Start menu.

Option 3: From Kaspersky AV Control Centre. If you install Kaspersky AV Control
Centre and set your anti-virus monitor to start automatically, the program will
be started right after you start Kaspersky AV Control Centre. However, in
this case the monitor icon will not appear on the taskbar.

Option 4: By entering the appropriate command in the command line. To do this,
go to the Kaspersky Anti-Virus directory and execute the avpm.exe file.

If your anti-virus monitor is enabled, you can see the icon D in the
system tray:
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when you place your mouse cursor on the icon E‘ the following prompt will pop
up: Kaspersky Anti-Virus Monitor is enabled;

the monitor system menu contains the following command: Disable Monitoring.

If your anti-virus monitor is disabled, you can see the icon E:‘!l in the
system tray:

when you place your mouse cursor on the icon E:‘!l the following prompt will pop
up: Kaspersky Anti-Virus Monitor is disabled;

the monitor system menu contains the following command: Enable Monitoring.

We do not recommend that you run two anti-virus monitors from
different manufacturers on the same computer. This may result in
conflicts and false alarms.

If you start your anti-virus monitor from Control Centre, its options
become unavailable. In this case you must use Control Centre to
change your monitor settings.

4.2. Program Interface

This section describes the Kaspersky AV Monitor interface, i.e., the system
menu, main window, work area, etc.

& When enabled, Kaspersky Anti-Virus Monitor can send you messages
upon certain events, for example, detection of an infected object.
Sometimes you have to respond to these messages. If you want to
complete the current working session on your computer, close all the
messages before logging off.

4.2.1. System menu

When you start your monitor the program main window will appear on your

screen (see subchapter 3.2.2), and you will see the monitor icon in the
system tray. Click this icon with your right mouse button to display the monitor
system menu (Figure 13). The system menu contains the following commands:

o Kaspersky Anti-Virus Monitor Settings — displays the program main
window.

e Disable monitoring / Enable monitoring — disables/enables the
program to monitor for viruses in files.
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e Show Report — displays a window containing the program performance
report.

e Update Now - starts the anti-virus database-updating program,
Kaspersky AV Updater.

e About Kaspersky Anti-Virus Monitor — displays a box containing
information about the program.

¢ Unload Kaspersky Anti-Virus Monitor — unloads the program from your
computer memory.

K azpersky Anti-¥Yirus Monitor Settings. .
Dizable monitaring

Show Beport
Update Mo

About Kazperzky Antiirg kanitor

Unload K.aspersky Anti-iz bMaonitar |

Figure 13. System menu

4.2.2. Main window

The Kaspersky AV Monitor main window allows you to change the monitor
settings, to disable/enable the monitor and to view the performance statistics
(Figure 14). You may close the window without unloading the program from your
computer memory.

The Kaspersky AV Monitor main window contains the following items:
e menu;
e toolbar;
e work area;

o the OK, Cancel, Apply and Help buttons.
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[C] Kaspersky Anti-Virus Monitor M=l E3
File  Monitor Toolz: Help
nje(Eg|a KAJPzR{ICY 2
Standard = Actions in zase of viug detection
Ask user
Expert 4
E - (C) Report anly
- O Disinfect
- () Rename object
- () Delete object
- Scan filez of following types
& Allinfectable
e O Al
B O Bymask
- [ Exclude by mask
Scan sectors
Scan compound files
----- Enable code analyser
J [
Mame | S\ze‘ Type ‘ Modified | =
O Elautce... 0 M5-DOS Batch File  2A15/01 120700 PM
O bootini 288 Configuration Setti..  2/15/01 3:52:48 Ak
O Confi 0 System file 2/15/01 12.07:00 Phd 1.
O lo.ays 0 System file 2M15/01 12.07:00 PM
O Msdo... 0 System file 2A15/01 12.07:00 P
[m ] ENtdet... 2E.. MS5-DOS Application  2/15/07 9:49:15 Ak ;I
kK I Cancel | Apply | Help |

Figure 14. The Kaspersky AV Monitor main window

4.2.3. Menu

At the top of the Kaspersky AV Monitor main window you can see a menu bar
with drop-down menus. Some commands in these menus may be substituted by
appropriate key combinations or toolbar buttons. The key combination that may
be used instead of a command is defined to the right of this command in the
appropriate drop-down menu. For the list of key combinations and toolbar
buttons that might be used instead of some menu commands refer to the table in

subchapter 4.2.4.

Menu = command

Function (The menu command allows
you to...)

File = Unload Kaspersky Anti- | unload Kaspersky AV Monitor from the

Virus Monitor

computer memory.

File > Close window

close the Kaspersky AV Monitor main
window.
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Menu = command

Function (The menu command allows
you to...)

Monitor > Enable monitoring /
Disable monitoring

enable/disable the program to monitor
for viruses (see subchapter 4.4).

Monitor >  View monitoring | display your monitor settings in text form

options (similar to subchapter 3.3.5).

Tools - Update Now update your anti-virus bases (see
subchapter 3.5).

Tools = Show Report display the report window (see

subchapter 3.4.3).

Tools = Make Virus List

generate a list of currently known viruses
(see subchapter 3.6).

Help > Contents

display the Help topics window.

Help = Kaspersky Anti-Virus on
the Web

start your web browser and go to the
Kaspersky Labs site.

Help = About Kaspersky Anti-
Virus Monitor

display information about the program.

4.2.4. Toolbar

The Kaspersky AV Monitor main window toolbar contains the following buttons:

Button | Menu > command

Function (The button and the
menu command allow you
to...)

"

Disable monitoring

Monitor - Enable monitoring /

enable/disable the program to
monitor for viruses.

»

Scan > Preview Monitoring

display your monitor settings in
text form.
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Button | Menu > command Function (The button and the
menu command allow you
to...)

@ Tools > Update Now start the anti-virus database-
updating program
Tools = Show Report display the report window
- File = Unload Kaspersky Anti- | unload Kaspersky AV Monitor
Virus Monitor from computer memory.
4.2.5. Work area

The work area of the main window is divided into two frames. The left frame
contains icons with the following names: Objects, Options, Customize and
Statistic. The right frame displays settings that correspond to the left frame icon
that is currently pressed.

The Objects frame allows you to define the locations and the objects that must
be checked for viruses, and to specify how the monitor must process objects that
have been defined as infected. All these settings are arranged in a special
control element, the objects settings hierarchy.

The Options frame allows you to define certain general settings, and you can
use the settings tree in the Customize frame to define advanced settings of your
Kaspersky AV Monitor (see subchapters 3.3.2 and 3.3.3).

The Statistic frame displays a table with the monitor performance statistics (see
subchapter 3.4.4).

Each item of the settings tree has a right-click menu with commands applicable
to the item.

@ To display the right-click menu of an item in the settings tree:

1. Place your mouse cursor on the required item.

2. Click your right mouse button. The appropriate right-click menu will
appear on your screen.
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4.3. Changing Settings

The options of your monitor are similar to the settings of your anti-virus scanner
(see subchapter 3.3).

They differ in the following ways: in the Objects frame you will not find the Scan
MS Outlook Express databases or the Scan start-up objects check boxes
and therefore you cannot monitor the objects defined by these settings. This
means that while monitoring you will not be able to disinfect mail databases.
However, your Kaspersky AV Monitor will be able to detect a virus in these
objects if you check the Mail databases and the Plain mail check boxes.

In the Options frame you will not find the Scan process priority option, since
Kaspersky AV Monitor utilizes an operating principle that is different from that of
Kaspersky AV Scanner. The Limit size compound files to (Kb) check box is
added to the frame. This allows accelerated monitoring of large archives, etc.
The numerical value for the required maximum size of a compound file to be
checked must defined in the appropriate input field near the Limit size
compound files to (Kb) box.

Note that in this version of Kaspersky Anti-Virus for Workstation,
Kaspersky AV Monitor scans for viruses and disinfects ZIP archives.

In the Customize frame you will not find the Pop up Scanner window after
scan finishes, Switch to "Statistic" tab after scan starts, Switch to
"Statistic" tab after scan finishes and Prompt next disk insertion for
removable drives check boxes.

If you check the Scan sectors and Scan memory boxes sectors and
memory will be checked only once, when monitoring is started. In
addition, if you check the Scan memory check box the program will
monitor for viruses in the memory of launched programs. Kaspersky AV
Monitor performs this check, right after it is loaded, and also every time
you update your anti-virus databases. If the infected memory of a
program cannot be disinfected, the program is forced to abort.

4.4. Loading, disabling and enabling
Kaspersky AV Monitor

You can manually load your anti-virus monitor from Kaspersky AV Control Centre
or from the Kaspersky AV Monitor main window. You can also use Kaspersky AV
Control Centre to schedule your anti-virus monitor to start automatically.
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After the program has begun monitoring for viruses you can disable it, and then
resume the process.

Main menu - | System menu Toolbar
command

Disabling Monitor - Disable | Disable monitoring I
monitoring

Enabling Monitor - Enable | Enable monitoring I
monitoring

4.5. Viewing performance statistics

If you enabled the monitor to report on its performance you can view the
statistics in progress in the Statistics frame (Figure 15).

[[] Kaspersky Anti-Virus Monitor | O] %]
File Monitar Tools Help

e 8-
Standard ‘

Thursday, October 18, 2001 11:46:17 A Kaspersky Antiirus Manitor started.
Anti-vinis bases were lnaded. Known viuses: | 48052

Scanned:

Sectors 2

Files 459

Archives 0

Packed files 0

Last object C:AWINNT WProfilesinzemtsovahApplication

Found:

Known vituses
Virus bodies
Disinfected
Delsted
Fienamed
Quarantined
W arnings
Suspicious
Corrupted

140 Emors

cooocooocooo

Ok I Cancel | Sappl Help

Figure 15. The Statistic frame

The frame table is divided into two sections: Scanned and Found. The Scanned
section displays the numbers of checked sectors, files, folders, archives and
compressed files. The Found section displays the numbers of:
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e viruses detected;
e virus bodies (the number of files infected by a known virus);

e disinfected objects (the number of objects from which viruses were
correctly deleted);

o deleted objects;
e renamed objects;

e warnings (the number of objects containing codes similar to known virus
modifications);

e suspicious objects (Code Analyzer notifications);
e corrupted objects;

e |/O errors.

4.6. Updating anti-virus databases

You may start the anti-virus database-updating program from your Kaspersky AV
Monitor main window. To do this, select the Update Now command from the

Tools menu or click the toolbar button 'ﬁ .



CHAPTER 5. KASPERSKY ANTI-
VIRUS UPDATER

The Kaspersky Anti-Virus Updater (Kaspersky AV Updater) is used for
automated updating of anti-virus databases with virus descriptions, methods of
repairing infected files, and package components.

The Kaspersky AV Updater can copy anti-virus databases and executable
modules from the Internet (using a network or remote connection), a Local
Folder, or an anti-virus server administered by Kaspersky Administration Kit.

5.1. How to start the Kaspersky AV
Updater

There are several ways to start the Kaspersky AV Updater. You can start it:

Option 1: From the Windows Main menu. To do this, go to the Start menu, then
to Programs submenu, and click on the Kaspersky Anti-Virus Updater
option in the Kaspersky Anti-Virus group.

Option 2: From the Control Centre (automated). With Kaspersky AV Control
Centre installed you can create a task to automatically start the Kaspersky
AV Updater (see Control Centre chapter for detail).

Option 3: From the command line. Go to KAV Shared Files common folder and
click on the avpupd.exe file. The common folder can be located at the
following path: C:\Program Files\Common Files\KAV Shared Files.

5.2. Kaspersky AV Updater interface

The design of the Kaspersky AV Updater interface is similar to a Windows
Wizard and consists of a sequence of boxes (steps), which can be navigated
with Back and Forward buttons. To finish updating, click on Finish; to close the
program at any stage, click on Cancel.

The Tree Chart element is located in the middle of each box (see Chapter 8 for
usage instructions). The control element configuration settings are grouped in a
hierarchical tree.
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5.2.1. Step 1. The Welcome wizard box

After the updating program has been started the Wizard will open the first wizard
box — Welcome (Figure 16) . Checking the Change settings box allows you to
set up the update mode, objects for updating and report options. Otherwise, the
steps described below will be omitted.

£ Kaspersky AV Updater

S

Welcome to the Kaspersky Anfi-Virus
Updater Wizard

Thiz wizard will guide vou through the updating of the installed
Kaspersky AV products.

: @ Kasperzky &% Updater Wizard will update:
- Anti-winis bazes
- Evecutable modules

|Ipdate file zource:
- hitp:/ /downloads-uzl kaspersky-labs.com/updates

To cortinue, click Next.

o [ Change settings

< Back Cancel Help

Figure 16. The Welcome wizard box.

5.2.2. Step 2. The Connection wizard box

If you decide to change the default settings, you can do this in the Connection
wizard box (Figure 17).
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% Kaspersky AY Updater

Connection .
Select the method you prefer for updating Kaspersky &% products. i @

=] URL
<[ User name <>
<[ Password gy
-------------- Connechions
= ) Update Kaspersky Anti-vins from Local Folder
Update Antivinuz Bases
- Update Executable Modules
[0 Restart computer if needed

< Back I Mest > I Cancel Help

Figure 17. The Connection wizard box

The Connection wizard box allows you to define the updating mode and the
object to be updated. Below we describe functions of the first-level options in the
settings tree (Figure 18):

0] Undate Kaspersky Anti-Wirus from Internet

- Update Kaspersky Anti- Virus from Local Folder
- ] Update Antivirus Bases

- [ Update Executable Modules

Figure 18. The first level of the configuration tree

@& Update Kaspersky Anti-Virus from Internet — select this option to update
via the Internet;

@ Update Kaspersky Anti-Virus from Local Folder — select this option to
update from a user-defined local folder;

Bl Update Antivirus Bases — check this box to update anti-virus databases;

Bl Update Executable Modules — check this box to update executable
modules of the Kaspersky Anti-Virus package.
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[l Restart computer if needed — check this box to restart the computer if
required after the package executable modules are updated.

When you have defined settings in this box press the Next button to proceed.

5.2.2.1. Updating via the Internet

If you chose to update via the Internet, expand the Update Kaspersky Anti-
Virus from Internet branch and define the required settings (Figure 19). Below
we describe functions of the branch options.

SENOR||ndate Kaz (0 Antiinas fram Intermet
[ URL

Uzer name <>

b [imag - Pagaarg ¢ s,

.............. Connechions

Figure 19. Options located on the Update Kaspersky Anti-Virus from Internet branch

=2 URL - use this button to define the source of updates (protocol, server
name, etc.).

User name — use this field to define the user name allowing access to the
updating server.

[ Password — use this field to define the password allowing access to the
updating server.

= Connections — use this branch to define the remote server connection
settings.

& If Microsoft Internet Explorer works in the Work Offline mode, the
program cannot be updated via the Internet even if the connection
settings have been manually adjusted.

5.2.2.1.1. Defining URL

You can download updates from one of the updating servers defined in the URL
list. To view the list expand the URL branch of the settings tree (see Figure 20).
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- hitp: Afdownloads-us1 kaspersky-labs. comdupdates

- frp: A ftp. downloads-us1 kaspersky-labs. comd/updates
- hitp: Afupdates3 kaspersky-labs. comdupdates

- hitp: Afupdates2 kaszpersky-labs. comdupdates

- hitp: /fupdates] kaszpersky-labs. comdupdates

-] Use random URL in list a3 starting point

Figure 20. Defining the updating server address

When beginning to update, the program by default uses the first URL in the list.
Other servers will be used one-by-one if the updater fails to download updates
from the first URL. An error connecting to the server message will appear on
your screen if the updater fails to download updates from any of the URLs in the
list. If you check the ¥l Use random URL in list as starting point box, the

program will randomly choose a URL from the list and will try to connect to this
server first.

The list of URLs may be edited. To do this, press the button =l URL; the Edit
URL list dialog box will appear on your screen (see Figure 21).

Edit URL list

URL |
@ http: //dovenloads-us1 kaspersky-labs comAupdates

@ ftp:/Aftp.downloads-us1 kasperskylabs.com/updates

@ hitp: /updates 3. kaspersky-labs, comdupdates

@ http: /fupdates2 kaspersky-labs. comdupdates

@ http: /fupdates. kaspersky-labs. comdupdates

'@ http: //downloads 1. kaspersky-labs. comupdates

@ hittp: £ v, avp. udupdates

@ ftp:/ fftp.updates 3 kaspersky-labs. com/updates

@ ftp:/fftp.downloads] . kaspersky-labs. comdupdates

= | X+ K

Ok I Cancel Help

Figure 21. The Edit URL list dialog box

To edit the list you must use the following buttons in the dialog box (or the
corresponding commands of the right— click menu):

ﬂ — allows you to add a URL to the list;
— allows you to edit the URL highlighted in the list;

E — deletes the URL highlighted in the list;
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ﬂ — moves the URL highlighted in the list one line up;

ﬂ — moves the URL highlighted in the list one line down;

5.2.2.1.2. Defining the IP connection

Depending on the method you choose to connect to the updating server, you
must define the following IP connection settings (Figure 22):

E .............. Connection

3 — Dial-up settings

o — LAM zettings

------ Ilze paszive mode FTP transfers

Figure 22. Defining the IP connection

& Dial-up settings — use this branch to define the dial-up connection to your
IP;

= LAN settings — use this branch to define the connection to your IP via the
local network.

[ Use passive mode FTP transfers — use passive mode when working with
an FTP server (this is especially useful for those connecting to an IP via a
proxy-server or a firewall).

Dial-up settings

i Automaticaly connect on start
e Automaticaly dizconnect on exit

Figure 23. The dial-up options
When configuring a dial-up connection you can check the following boxes
(Figure 23):

Bl Automatically connect on start — dial up automatically to your IP
immediately after starting the updating process;

B Automatically disconnect on exit— disconnect automatically
(switch off the modem) after the updating process is completed.
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. Connect To 2x|
i
@ I Internet j
User name: Iklim|
Pazzword: I

[ Save password

I™| Connect sutamaticalls

Phane number: IEMEIBESE
Dialing from: INew Location 'l Dial Properties...l

Connect I Froperties | Cancel |

Figure 24. The Connect To box

If you have chosen the
automated connection feature
to set up a remote access to
your |IP, the program will
enable the standard remote
access utility (unless you
have installed another one)
after you start the updating
process.

To connect to your IP fill in the Connect To box (Figure 24) and click on
Connect. A remote server will be dialed and connected to. During the dial up
the Connecting to Internet box with the Dialing message in the Status line

will be displayed. (Figure 25).

= 5
=z Connecting to Internet

Statuz: Dialing...

Cancel |

Figure 25. The Connecting to Internet box.
Dial-up

) :
= Connecting to Intemnet

pazsward...

Statuz: Verifying uzer name and Cancel |

Figure 26 .The Connected to Internet box.

Username and password verification

While dialing, the program
displays the Connecting to
Internet box with the Dialing
message. When you have
dialed in successfully, your
username and password will
be verified.

In the Status Iline the
message Verifying user
name and password... will
appear (Figure 26).
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x| If the wuser cannot be
identified by his settings the

Enter pour pazsword to connect. User Logon box (Figure 27)
Lser name: Iklim Cancel | will appear with sSpaces for
Password | the. foIIowing. copnection

_ settings to be filled in: User
Logon domain: |1 name, Password, Logon

domain.

Figure 27. The User Logon box

When you have connected to
the Internet, a special symbol
will appear on the taskbar.

&
“s Connected to Internet

1 Connected at 26 400 bps
Duration; 000:00:03
Bytes received: 5E0
Buytes zent: 1 0BS

Disconhect

==l
=

Detailz >

Figure 28. The Connected to Internet box.
Connection settings

To view the connection settings double-click on the relevant icon on the
taskbar (Figure 28).

= LAM zettings If you use a local network for
- {® Usze Intemnet settings from Control Panel your IP connection you can

- € Setup Intemet settings manually choose the settings from the

. ) Control Panel, or configure

Figure 29. LAN settings the connection manually

(Figure 29), i.e.:

® Use Internet settings from Control Panel — select the connection
settings defined in the Control Panel;

& Setup Internet settings manually — define the connection manually.
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- IE) Setup Internet settings manually If you have chosen to define
El se a prowy server [Firewall] the connection manually,
; Address <> you must define the
~E Part <0 following settings (Figure
- Authorization 30):

_ Izer name <3
o o[ Password e
i [ HT TP prosy with FTP support

Figure 30. The settings to be defined manually

Bl Use a proxy-server (Firewall) — check this box to use a proxy-server or a
firewall to connect to the IP;

Address — use this field to define the required proxy-server (or
firewall) address. You can define the address using the decimal
notation (e.g., 125.5.29.1), or the full domain notation (e.g.,
test.russia.ru), or the short notation (e.g., test);

El' Port — use this numerical field to define the proxy-server (or firewall)
connection port;

Bl Authorization — check this box to define the user’s individual settings;
User name — use this field to define the user name allowing access
to the proxy (or the firewall);
[ Password — use this field to define the password allowing access to
the proxy (or the firewall);
[ HTTP proxy with FTP support — check this box to access the FTP
server via the HTTP-proxy-server (CERN-proxy);

Contact your network administrator for more details about the above settings.

5.2.2.2. Updating from a local folder

If you have chosen the Local Folder as a source for updating you must give the
full pathname of the folder.

- @ Update Kaspersky Anti-Virus from Lacal Folder — \When you click on the button
£ (which is outlined in Figure 31), a

Figure 31. Update from the local folder box will open, where you should
choose the updating folder.
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5.2.2.3. Choosing objects to be updated
There are the following two check boxes at the bottom of the settings tree (Figure
32):

------ pdate Antivirus Bases
“- [ Update Executable Modules

Figure 32. Choosing objects to be updated

B Update Antivirus Bases— check this box to update anti-virus databases;

Bl Update Executable Modules — check this box to update executable
modules of the Kaspersky Anti-Virus package.

[4 Restart computer if needed — check this box to restart the computer if
required after the package executable modules are updated.

5.2.3. Step 3. The Options wizard box

In the Options box you can configure advanced features of the updating
program (Figure 33).

&F Kaspersky AV Updater

Options
Specify additional Kaspersky AY Updater ‘Wizard options such as report file, ete.

=] avpupdrep
O #ppend

Show progress window

< Back I Mext > I Cancel Help

Figure 33. The Options dialog box

Bl Use Report— check this box for the program to generate a report about the
updating process.

& Report file — use this branch to define the report file name and the
location.
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[l Append — check this box to append new data to the existing report file.
If you uncheck this box the program will overwrite the existing report
with a new one each time the updating operation is performed.

[4 Limit size of report file (in Kb) — check this box to define the
maximum file size in the numerical field below. The file will be
overwritten when the limit is exceeded.

= Advanced — use this branch to configure the user interface;

El Show progress window — check this box to display the updating
operation progress window (see below).

Press the Next button to proceed with the updating operation.

5.2.4. The Reftrieving updates window

This window (Figure 34) will appear only if you have checked the Show
progress window box in the Advanced branch of the Options box.

&% Kaspersky AV Updater

» Connecting to server

|ft|3: /tp.downloadz-us1 kaspersky-labz. com/updates,

D ownloading files

Installing files

Dizconnecting

< Bach: HERt> Help

Figure 34. The Retrieving updates window

The window consists of four parts, showing stages of anti-virus database
updating in progress:

e Connecting to server — connection to the source server for files to
download,



Kaspersky Anti-Virus Updater 64

e Downloading files — files copied from the server to the computer (the
name of the copied file is displayed at the top, the percentage
downloaded is displayed below);

¢ Installing files... — files are installed onto the computer (the name of
the installed file is displayed on top, the scale of the updating process
completion is shown below);

e Disconnecting... — connection session is over.
The level of completion is shown by the icon located to the left of the above
messages (the icon is displayed only when the corresponding part is being

updated). The / icon indicates a successful completion of this part of the

updating process, while shows that the updating program is executing this
part at the moment.

5.2.5. Step 5. The Finishing wizard box

This is the last box (Figure 35) where you can view the updating report (click on
the Report button) and check or uncheck the Visit the Kaspersky Labs Web
Home Page box for the latest news about KAV products box.

Click the Finish button to finish a work session with the program. If you have
checked the corresponding box Internet Explorer will automatically open the
Kaspersky Labs web site.

ersky AY Updater

. _ Finishing Kaspersky AV Updater
Wizard

@ K.aspersky A products cumently installed on your computer dao
not require updating.

To cloze this Wizard, click Finish.

T V! Wisit the K.aspersky Lab Web Home Page for the latest news
about K.azpersky AW products

< Black I FEinizh I [Earce] Help

Figure 35. The Finish box




CHAPTER 6. KASPERSKY ANTI-
VIRUS CONTROL CENTRE

The Kaspersky AV Control Centre is a component of the Kaspersky Anti-Virus
package. It performs the functions of a management shell. You can use it to
install and update package components, define and schedule tasks to be started
at the appropriate time, and to review the task performance results.

The program allows you to keep track of what Kaspersky Anti-Virus components
are installed on your computer, which makes it easy for you to communicate with
the Kaspersky Labs technical support service, and to update your anti-virus
databases and components in a timely fashion.

Using the Kaspersky AV Control Centre, you can schedule the launch of the anti-
virus programs included in the package. In this way you can improve you
productivity and at the same time keep your system safe from viruses.

The automated launch of the external programs allows you to use the Kaspersky
AV Control Centre as a conventional task scheduler. Most commonly there is no
need to use other tools of automated launch, which leads to more effective use
of your computer resources. Additionally, the exact mutual synchronization of
your processors is insured, provided that the processors are connected to the
system’s anti-virus safety system and other tasks, thus excluding the possibility
of conflicts.

6.1. Launching Kaspersky AV
Control Centre

There are several ways to launch your Kaspersky AV Control Centre:

Option 1: From the Windows Main menu: click the Start button, then go to the
Programs submenu and click Kaspersky Anti-Virus Control Centre in the
Kaspersky Anti-Virus folder.

Option 2: Automated launch at Windows start-up before the logon procedure
(only if Kaspersky Anti-Virus Control Centre is installed).
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When Kaspersky AV Control is
successfully launched, in the taskbar
notification area you will see the icon

K. Place you mouse cursor on it,

_~ KAV Control Cenbie. ..

Import zettings...

Export gettings... right-click, and you will see the user

@ H menu (Figure 36), which includes the
Help - )
following commands:

B About...

E uit
IIWQ[E

Figure 36. The Kaspersky AV Control
Centre menu in the taskbar

o Kaspersky AV Control Centre...— displays the program main window;

e Import settings... — allows you to import program settings from a user-
defined file (see below);

o Export settings... — allows you to save the current program settings to a
file with the .dat extension. Later you will be able to import settings from
this file (see above);

e Help —displays the Help topics window;

e About ... — displays information about the product version, the license
name, the license expiration date and more (see Figure 37);

o Exit — exits the program.

The Export settings and Import settings commands allow you to copy
Kaspersky AV Control Centre settings from one computer to another, i.e.
you can set the program on a computer, then save the program settings
to a file in a shared folder on the server, and later download these
settings onto another computer.

At the top of the user menu above the line, you can find a list of tasks that
can be started manually. To start these tasks you do not have to display
the Kaspersky AV Control Centre main window; you may simply select
the required command from the menu.
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About Kaspersky AY Control Centre
Kaspersky Anti-Virus Control Centre

Yersion 4.5

This praduct is licensed to:

Boronina Olga

Kasperzky Lab

Kep Mumber | Licenze | Description | E=pira
00C3-000055-0000EEF2  KAW Ewhibition ke 1% CeBIT-2001, NFR - 9/3/0

KAJPIR{KY £

@-i-'-_ Support... ‘ | _’I
== Modules. .. Copyright ® 1337-2003 Kaspersky Lab
| Portion copwright © LanCrpto

Figure 37. The About Kaspersky AV Control Centre box

Here we must mention some special features of the program. Kaspersky
AV Control Centre is divided into the following two sub-programs: a
service sub-program that is started as a system service even before the
logon procedure, and an interface sub-program that provides the
program’s graphic interface and supports communication between a user
and the program. If you unload only the interface subprogram, the tasks
defined in the Kaspersky AV Control Centre settings will still be
performed, but the user will not be able to edit settings and create new
tasks. If you unload the service sub-program as well, Kaspersky AV
Control Centre will abort the defined tasks.

Option 3: From the command line. To launch Kaspersky AV Control Centre from
the command line, go to the KAV Shared Files folder and run avpcc.exe.
The common folder can be located on the following path: C:\Program

Files\Common Files\KAV Shared Files.
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6.2. Kaspersky AV Control Centre
interface

The program main window contains the following four tabs: Tasks,
Components, Settings and Quarantine (for details see below).

To perform various actions you can use the right-click menu or the control panel.

In the bottom of the window you can see the following buttons: OK, Cancel,
1A

Apply and = | If you press the OK button, the changes you made to the
program settings will be saved; if you press the Cancel button, the changes you
made will be cancelled. In both the cases the main window will be closed. If you
press the Apply button, the changes you made will be applied and the main
window will remain on your screen; in this case you can continue to change
settings. For the resident tasks performed at this moment the applied settings will
be immediately loaded into the executable module. To display the Help topics
window press the Help button.

6.2.1. The Tasks tab

The Tasks tab (Figure 38) allows you to manage the tasks. The task is
understood as a program with predefined settings that is scheduled to start at
some certain time, or upon some event, or as required by the user.

The page contains three frames:

¢ In the left upper frame you can see each task listed with its corresponding
status;

e In the right upper frame you can see the current task performance
statistics”;

¢ In the lower frame you can see the list of events that have occurred
(errors, warnings, notifications).

Let’s have a look at each frame. The task list is divided into two columns: Name
and Status. In the Name column you will see the list of tasks, and in the Status
column — the respective task execution status. There are several status variants:

¢ Running - the task is being executed;

! Program performance statistics — a short form of the report on the program
performance.
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¢ Finished — the task has been successfully executed;

¢ Fail — a failure occurred during execution of the task;

¢ Interrupted by user — the task was interrupted by the user;
o Pause - the task is suspended;

e Start — the task is launched;

e Stop - the task is stopped;

o Start fail — task launch error;

¢ Restart — the task is restarted.

Kazpersky Anti-¥irus Control Centre
IEE 5 [ Companents | ™M@ Settings | 3 Quarantine
Name | Status Statistics for: Start Kaspers... U Sl
. Start Kaspersky Anti-Viru...  » Running | [<] =
linans Thurgday, October.. Kaspersky Antidvi J I
Update anti-virus bases . %
Daily at 7:30 P seamed ik
Sectars 3 .
: = Files 10
{Start Kaspersky Anti-_. | ® Canceleq| - 2
2| |iDaiy atm:00PM duchives 1
: Packed files i N
| | _'I Fournd: LI ®
Lazt events in Kaspersky & Control Centre | Date -
File placed in quarantine 10411401 B:10:11
Sender: Start Kaspersky Anti*viruz Monitor -
4| | 3
0K J EanceI_J Apply J |

Figure 38. The Tasks tab

In the right part of the window you will see the statistics bar. The contents of the
statistics bar depend on the task type.

Thus, for example, the automated update task has the following lines in the
statistics bar: Date, Time, Action, Result and Object, which respectively display
the date and time of the task launch, the undertaken actions and their results,
and the object to which the action was applied.

At the bottom of the main window you will see a list of events with a date and a
time when they occurred, and the component that generated the corresponding
alert. Event alerts are delivered to Kaspersky AV Control Centre from all the
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running components of the package. You may sort the list lines by any column,
alphabetically or numerically, in ascending or descending order. When you select
an event from the list the task that generated the corresponding alert will be

highlighted.

> Delete
Delete al

Figure 39. Context menu in the event

list

The list has a context menu (Figure 39).
The context menu items are used for the

following actions:

e Delete — deletes the selected event (with confirmation);

¢ Delete all — deletes all events from the list (with confirmation).

To carry out task management (such as creation, configuration, removal, launch,
and termination) use the right-click menu, and the Tool Panel buttons (Figure

40).

B Start
W Slop

Il Pauze
% Feload bazes

|7 Enable

Properties. .

Figure 40. Right-click menu for the tasks list and the Control Panel on the Tasks tab

Copy
2 Faste
75 Delete

Rename
1+ U
& Down
Expart...

Impaort....

e =X D F o<
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To open the right-click menu, click with your right mouse button in the left part of
the window, where the tasks list and the status bar are located.

The right-click menu commands allows you to...

Start — launch the selected task;
Stop — terminate and unload the selected task that is running;

Pause — pause the selected task. In this case the task is retained in
memory but its performance is suspended;

Reload databases — reload the anti-virus databases. This command is
used when you wish to load the updated anti-virus bases into memory-
resident tasks without restarting them;

Reset statistics — clear the selected task performance statistics (only for
memory-resident tasks);

New task — create a new task. If you select this command, the New Task
Wizard will be launched (see subchapter 6.3);

Report — display the selected task performance report in the Kaspersky
Report Viewer window (see Chapter 7) ;

Enable — enable/disable the selected task to be started as scheduled. If
you disable the task, it will still be listed, but the task planner will not
launch it.

Properties — display the selected task settings.

Edit — change the selected task settings. By pointing to this command
you drop down a sub-menu with the following commands:

e Cut — cut the selected task from the list and place it into the
internal clipboard of Kaspersky AV Control Centre; the task
name, settings, and the appropriate schedule will be saved;

e Copy — copy the selected task into the internal clipboard;

e Paste — paste a task from the clipboard into the program task
list;

e Delete — delete the selected task from the list;
¢ Rename - rename the selected task;
e Up — move the selected task one line up;

e Down — move the selected task one line down;
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o Export — save the selected task to a file. If you select this
command, a window asking you to save the task settings in a
file with the .tsk extension will appear on your screen;

e Import — download a task from a file.

The Export and Import commands allow you to copy the required task settings
from one computer to another, i.e. you can create a task on a computer, then
save these task settings to a file in a shared folder on the server, and later
download this settings file onto another computer.

Some commands may be unavailable for some task types. The tasks are
launched in the order in which they are listed. Task management, as we have
mentioned above, can also be accomplished using tool bar buttons. The
following buttons correspond to the right-click menu commands:

Button Right-click menu command

b Start
m Stop
] Pause

@f; Reload databases

s Reset statistics

Report

5 New task

Properties

p .y Delete

When you place your mouse cursor on a button, a tip describing the button
function will pop up near this button.

You can use the following methods to manipulate tasks:

e Pressing a letter key — you can switch between the list items by pressing
the key corresponding to the first letter of the target item name.

e Using other hot keys:
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e <INSERT> - create a new task. If you press this key, the New task window
will appear on your screen (for details refer to subchapter 6.3).

o <DELETE> — remove the task from the list (with confirmation).

e <SPACE> — show the selected task properties. If you press this key, the
Properties window will appear on your screen (For details refer to
subchapter 6.2.1.1).

For exam if there is a task called Automated update in the list, and you

press the key on the keyboard, the list pointer will move to this task.

6.2.1.1. The Property window

This window appears when you press the button or select Properties in the
context menu. The window appearance depends on the task type, which it
describes.

In this product version there are the following window variants:
e The Kaspersky Anti-Virus Scanner task property window;
e The Kaspersky Anti-Virus Monitor task property window;
e The Kaspersky Anti-Virus Updater window;

6.2.1.1.1. The Kaspersky Anti-Virus Scanner task
property window

The Kaspersky AV Scanner task property window (Figure 41) contains
categories with a list of settings.
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{3 Properties - Start Kaspersky Anti-¥irus Scanner

[ [O] <

B- |___| =) My Computer
-0 &% Flopw 8]
[

. & (D)
-0 @ 05prmcddl [E:]
[0 &2 Boxeson ‘hvp_server [F:)

[0 52 Bua Tracker on ‘Avp_server2 [C
-0 52 Localization on ‘Avp_server' [L:]
-0 52 Release on '4vp_server (M:)
-0 2 Distributiv on ‘Avp_server' [F:)
-0 &2 Testing on ‘hvp_server2' L)
- S RelCandidate on Avp_server?' |

<

Actions in case of vinug detection
(@ Ask user
- Report only
- Disinfect
-3 Rename ohject
O Delete object
O Scan local remavable disk drives
------ Scan local hard disk drives
O Scan network dives
Scan files of following types
Scan sectors
Scan memony

Scan StartUp objects
Scan compound files of the fallowing typ
Enable code analyser

Cancel |

Figure 41. The Kaspersky Anti-Virus Scanner task property window

The window contains the following categories:

Category Reference

Objects See subchapter 3.3.1
Options See subchapter 3.3.2
Customize See subchapter 3.3.3

User account

See subchapter 6.3.5

Schedule

See subchapter 6.3.3

Alerts

See subchapter 6.3.4
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6.2.1.1.2. The Kaspersky Anti-Virus Monitor task
property window

The Kaspersky Anti-Virus Monitor task property window consists of categories
that contain the task settings (Figure 42). Some of the categories match those
located in the corresponding component main window; other categories are
specific only to Kaspersky AV Control Centre.

D Properties - Start Kazpersky Anti-Viruz Monitor

2 by Computer = : "

=3 37 Floppy [&:]
= IC] Scan local hard disk drives
e N (v Scan network drives

@ 03prmedd [E:) [ Scan filez of following types
Scan sectors

------ Scan memary

M %ean compound files

------ Enable code analyser

[+

Ok I Cancel Help

Figure 42. The Kaspersky Anti-Virus Monitor task window

Let's explain the tab’s purposes.

Category Reference

Objects, Options, | See subchapters 3.3.1, 3.3.2, 3.3.3.
Customize

Schedule See subchapter 6.3.2.

Alerts See subchapter 6.3.4.
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6.2.1.1.3. The Kaspersky Anti-Virus Updater task
property window

The Kaspersky Anti-Virus Updater task property window contains tabs with the
task settings (Figure 43).

58 Properties - Update anti-vius bases

- ) Upd
- Update Kaspersky Antitirus from K.aspersky AY Server
[¥] Update Artivirus Bases
Update Executable Modules

g Scheduls

HEE|

0K I Cancel

Help

Figure 43. The Kaspersky Anti-Virus Updater task property window

Tab Reference
Connection See subchapter 5.2.2
Options See subchapter 5.2.3

User account

See subchapter 6.3.5

Schedule

See subchapter 6.3.3

Alerts

See subchapter 6.3.4

The Connection page in the property window contains an additional

option that allows updating of your

anti-virus databases and

executable modules in the folder of the Kaspersky AV Server. This is
the Update Kaspersky Anti-Virus from Kaspersky AV Server

option button.
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6.2.2. The Components tab

The Components tab (Figure 44) contains a list of Kaspersky Anti-Virus package

components?,
Kaspersky Anti-Virus Control Centre M=l 3
o Settings | 7 Quarantine
Name | Falder al um
Kaspersky Anti-Virus Baszes (| C-‘Program Files\Common Files\K._.. T
+ Last update: Tuesday, October 02, 2001
+ Language: English 3
Kaspersky Anti-Virus Scanner 1 C:\Program Files\Kaspersky Lab\K... @
« Yersion 4.5 73

+ Language: English

Kaspersky Anti-¥irus Monitor
+ersion 4.5
+ Language: Englizh

@ C-\Program Files\Kaspersky LabA\K. .

Kaspersky Anti-¥irus Mail Checker
+Yersion 4.5
+ Language: Englizh

& C:\Program Files\Kaspersky LabA\K...

1|

R

ak J Cancel _J

Apnll J @J

Figure 44. The Components tab

The tool bar is located in the right part of the tab; when you right click on it, the

context menu appears (Figure 45).

p Bun
3 Open companent's falder

@ Component help
B About...

Figure 45. Context menu and the tool bar on the Components tab

2 Component —a program, utility, library or database, included in the Kaspersky Anti-
Virus package, which is responsible for a strictly limited number of tasks.
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The tool bar buttons are strictly correspondent to the items of the context menu
(see below).

Button | Context Description
menu item
% Create task Creates a new task based on the selected

......

component. If you click on this button or select this
menu entry, the New task window will open (see
subchapter 6.3)

b Run Launches a task based on the selected component
5 Open Shows the component's folder in a standard
component's | window.
folder

Component Launches the help system for the selected
help component

R About Displays the information about the product version,
date of the last anti-virus bases update, and more.
If you click on this button or select this menu entry,
the About window will open.

6.2.3. The Seftings tab

The Settings tab (Figure 46) allows a user to define Kaspersky AV Control
Centre settings. The settings are divided into four categories. Every category
groups settings with well-defined functionality.

The list of categories (icons) is located in the left pane of the window. When you
select a category, the appropriate settings tree appears in the left panel (see
Chapter 8 for information about the settings tree).

If the window’s size is not sufficient to display all the categories, the

| and =l buttons, allowing you to scroll the category list, appear at
the top and the bottom of the list.
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Paszzword pratection

jne| Pazsward; ¢,

O Pratect residert task stapping

[0 Pratect noreresident task stopping

[ Pratect Kazpersky & Contral Centre settings modification
[0 Pratect Kaspersky &% Caontral Centre exiting

Dizabled tazks

Rur uzer program

oK, J Canci_’ EDD'&JJ _@J

Figure 46. The Settings tab

Category Function

This  category contains  parameters
responsible for the system’s safety and
limiting access to Kaspersky AV Control

Security Centre components;
This  category contains  parameters
responsible for processing alerts about
critical events in the Kaspersky AV Control
Alerts Centre task performance;
Tl This category contains settings for the
Eq location of quarantined files on this
computer or server (makes sense only if
Quarantine Kaspersky Administration Kit is enabled)

(see below for information  about
Quarantine).
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Category Function
‘m This category contains options for remote
= | administration via Kaspersky Network
Control Centre
Remote management (these options are only for those who use a

Kaspersky Administration Kit software
package that includes the remote
administration program);

"{, This category contains user interface
customization settings for Kaspersky AV

Control Centre.

Customize

6.2.3.1. The Security category

“_ Kaspersky Anti-Virus Control Centre This category (Figure 47) is used
2% Components PRl 3. Quarentine | for setup of system safety features.
It is responsible for password setup
and access and denial to some
task types.

Figure 47. The Settings tab. The Security
category

The Kaspersky AV Control Centre allows you to protect some running actions by
a password. In that way user access to the specified commands is limited.

P_Iassg'md Dro;ection These features, as mentioned
il Pazaward: ¢ ., .
‘O Frotect resident task stopping abo\./e, are regulated in the t.l‘ee
‘O Frotect non-resident task stopping section for Password protectlon

[ Protect Kaspersky & Contral Centre settings modification (Figure 48)
[ Protect Kaspersky A% Cantral Centre exiting

Figure 48. Password protection section

This section contains the following options:

2l Password — enter an administrating password for Kaspersky Anti-Virus
using Kaspersky Anti-Virus Control Centre. This password will prohibit users
from accessing some program functions (the list of corresponding functions
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is located below in the settings tree). If you press the 2l button, the
Change password dialog box will appear on your screen.

rernp peoead This box (see Figure
49) allows you to
define and change
New passward: the password. Enter
 — your password in the
Confirm password: New password text
[ field and confirm it in
the Confirm

[0k | Corcel | Hep | password text field.

Figure 49. The Change password dialog box

B Protect resident task stopping — If you check this box, the program will
prompt for the password when somebody tries to stop resident tasks (for
example, Kaspersky AV Monitor) running on the computer.

B Protect non-resident tasks stopping — If you check this box, the program
will prompt for the password when somebody tries to stop non-resident tasks
(such as Anti-Virus Scanner or Kaspersky AV Updater) running on the
computer.

Bl Protect Kaspersky AV Control Centre settings modification — If you
check this box, the program will prompt for the password when somebody
tries to display the window and to change settings of Kaspersky AV Control
Centre.

B Protect Kaspersky AV Control Centre exiting — If you check this box, the
program will prompt for the password when somebody tries to unload
Kaspersky AV Control Centre from the memory.

When selecting a password-protected action, make sure to enter your
password in the Password text field!

In addition, this tab allows you to disable some task types that can be dangerous,
if somebody tries to remotely administer the package without any authorization
(system crack).

[=]-z Disabled tasks This feature can be enabled on the
- Fiurn user program Disabled tasks branch (see Figure 50).

Figure 50. The Disabled tasks branch

This product version has only one option available:
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Bl Run user program — If you check this box, user programs will be prohibited
from starting as Kaspersky AV Control Centre tasks.

6.2.3.2. The Alerts category

The Alerts category (see Figure 51) allows you to process remotely alerts
generated by the running tasks.

o (#Y Skip all alerts

) Process alerts via K.azpersky A% Server

) Process alerts by Kaspersky &% Control Ceritre
- [ Mawimum alerts for single task

=0

Remote management

it

¢

Quaranting

k. J CanceL_‘ appl_l,l“‘ E}

Figure 51 The Settings tab. The Alerts category

The settings tree contains the following options:
@& Skip all alerts — Disable the sending of alerts

@& Process alerts via Kaspersky AV Server — Send alerts using the
Kaspersky AV Server, the server component of the Kaspersky Anti-Virus
remote management system

@ Process alerts by Kaspersky AV Control Centre — Send alerts using the
Kaspersky AV Control Centre;

To limit the number of alerts to be generated by a single task, check the box [
Maximum alerts for single task and define the maximum value in the
corresponding field.
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For example, Figure 52 illustrates a situation when the maximum
number of alerts is limited to 10. This means that when Kaspersky AV
Control Centre receives the eleventh alert from a task, the received
alert list will be automatically cleared.

If the Process Alerts by Kaspersky AV Control Centre option is selected, you
should customize the settings for sending alerts. To enable the program to send
alerts via e-mail check the Send E-mail messages box. Then define the
following settings:

- {3 Skip all alerts

- Process alerts via K.aspersky AW Server

=l @ Process alerts by Kaspersky &Y Control Centre
== Send E-mail meszages

. From <
- Subject:

- Mail settings

E| & Send mail uzsing SMTP
[ SMTP server addiess: <>
B SMTP server port <25
El- O Masimum alerts for single task

E} ]

Figure 52. The Process alerts by Kaspersky AV Control Centre branch

To: Type the recipient’s e-mail address in this line;

From: Type in the name or address to be displayed in the From line
of an e-mail message. Any string can be the value of this line.
This setting is required for work with some SMTP servers and
is used for user authentication;

Subject: e-mail message subject;
Message: The message text to be sent with the e-mail;

Mail settings  Specify the e-mail system settings for alert sending methods.
There are two methods of sending:

e using MAPI;
e using SMTP.
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Contact your network system administrator for more information about
SMTP and MAPI.

6.2.3.2.1. Send mail using SMTP

= @ Send mail using SMTP To send alerts using SMTP, select the Send
= SMTP server address: <> mail using SMTP option (Figure 53), then
~Bll SMTP server port: <25>  select the following parameters:

Figure 53. SMTP settings

SMTP Server address Contains the SMTP server address, which can
be typed in as a decimal notation (e.g.
125.5.29.1), or as a full domain notation (e.g.
test.mail.ru), or a short notation (e.g. test);

SMTP server port Contains the SMTP server port address. The
default value is 25.

Let's study an example of tab Alerts settings usage. Let’'s say we need to set up
SMS-messages sending about critical network events to the mobile phone of a
system administrator via e-mail gate.

Input data:
e administrator's mobile phone number — 1234567 (direct number);

e telephone connection operator — Beeline GSM (i.e. the access code to
direct phone numbers — 7 901);

e SMTP server address — mysmtp.home.ru;
e SMTP server port — 25;
Make sure that:
e The message has been sent from the Control Centre,
e The message had the Alert subject,

e The message body contained the following text: Warning! There was a
critical event!
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Figure 54. Settings for sending critical event SMS

6.2.3.2.2. Send mail using MAPI

= @ Frocess slerts by Kaspersky &4 Control Centra
=

Send E-mail messages
S Te <
From: <»
Subject:
- Message:
o Mail setings
B @ Send mail using SMTP
- SMTP server address: <
B SMTP server part: <253

messages

To do this, define the
following settings (See
Figure 54).

The e-mail gate address, as well as the access code to the operator’s
cellular phone, can vary depending on the region.

If you have the Windows 95 OSR2/98 operating system running on your
computer, the Kaspersky AV Control Centre application allows you to set up
message sending through MAPI.

=~ @ Send mail using MAP]

Profile

Password

MAPI client

- Profile;

w2 Work with MS Exchange
[ Passward: s B

- MaP! client:

B Microsaft Outiook

Figure 55. MAPI settings

To set up MAPI parameters select the
Send mail using MAPI option (Figure
55), then enable the following settings:

Profile name (configuration file) of the
MAPI client;

Profile access password;

MAPI client name, which will be used

for sending alerts.

Some MAPI clients do not use profiles. In that case leave the
Configuration and Profile password lines empty.
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6.2.3.3. The Remote management category

This category is used for remote administration setup using the Kaspersky
Network Control Centre (Figure 56).

K.aspersky Anti-Yirus Control Centre

E |:|:|r|'||:||:|r'||3r'|t:5: E Settings m

o w2 Dizable remote management

= = &) Usze Kazpersky Nebwork Control Centre
e Security

o Uzed TCRAF parts

Security

I+

*
R emaote management

Figure 56 The Settings tab. The Remote management category.

To disable the remote management feature, select the Disable remote
management option; to enable the network functioning of the Kaspersky Anti-
Virus using Kaspersky Network Control Centre, set the selector to the Use
Kaspersky Network Control Centre position.

e ) Disable remate management
= {8 Use Kazpersky Metwark Cantral Centre

| — Seu:urit_l,l

Figure 57 Use Kaspersky Network Conrol Center option

After doing so, set up the program security parameters to networking, as well as
the used ports.

Security Network security setup with the Kaspersky Anti-
Virus remote management option enabled

Used TCP/IP Ports Setup of ports (TCP and UDP) used for
package components management



87

Kaspersky Anti-Virus for Workstation

6.2.3.3.1. Remote management security setting

E| Security
i Bl Bllowed IP addresses

e @ Allow all addresses

B O Allow addresses
e Mew Yalue

The remote management
security setting (Figure 58)
allows you to limit the number
of computers, which can
remotely manage the

for management computers

frarm Followed list :

Figure 58 Remote management security setting Kaspersky Anti-Virus

There are two options for t

components.

he system safety setup: enable the Control Center

administration for all network computers or set the IP addresses of the computers with
permitted remote management.

The Security tree branch co

Allow all addresses

Allow addresses from
followed list :

ntains the following items:

Gives permission to all network computers to
remotely manage the Kaspersky Anti-Virus
components installed on your computer

Gives remote management permission only to
computers with numerical IP addresses listed
below.

It is recommended to give remote management permission only to

your system administrator’'s computer. To do so, enable the allow
addresses from the list option, then add the system administrator’s
computer IP address to the list.

6.2.3.3.2. Remote management ports setup

- |Jsed TCRAP ports

; Efl K Cantiol Centre communication UDP part
Bl KAV Server communication TCP port: <8084>
‘Bl KAl Server commurnication UDP port: <8085:

Figure 59 Remote managem

Bl Ké¥ Cantiol Centre communication TCP part <8086> The TCP and UDP pOrtS are

<a0e7> used for the remote
management of the Kaspersky
AV Server and the Control

ent ports setup. Center. The default settings are
as follows:

Kaspersky AV Control Center communication TCP 8086

port

Kaspersky AV Control Ce
port

nter communication UDP 8087



Kaspersky Anti-Virus Control Centre 88

Kaspersky AV Server communication TCP port 8084
Kaspersky AV Server communication UDP port 8084

To enter new settings, go to the TCP/IP ports section (Figure 59), then enter the
new values.

6.2.3.4. The Customize category

Kaszpersky Anh-¥iruz Control Centre The Customize category

(Figure 60) contains the
2 Settings m program interface
settings. In this category
you can set up the audio
accompaniment of certain
actions execution, as well
as the colour mode of a
program setting.

e Play sound on event
e MDPEATENCE

Figure 60. The Settings tab. The Customize category

The Customize category includes two sections: Play sound on event and
Appearance. Here is their short description:

¢ Play sound on event — setting sound effect following the execution (or
completion) of specified operations (see subchapter 6.2.3.4.1 for further
detail);

e Appearance — set up the color mode of your program (see subchapter
6.2.3.4.2 for more detail).

6.2.3.4.1. Sound setup

The Kaspersky AV Control Centre application allows you to assign sound effects
to specified events. This gives your program some additional service features.

The sound setup, as mentioned above, is carried out on the Sound branch
(Figure 61).
To enable the sound, check the appropriate box and click on the corresponding

sl button to display the window, in which you want to select the audio file. This
file should be written in the WAV format. Let’s explain each sound’s purpose:
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Task start — Play the sound immediately after the task launch (not
regarding its type).

Task finished successfully — Play the sound at successful task
completion, i.e. in case the task hasn’t been canceled by the user and
hasn’t terminated with errors.

Task canceled by user — Play the sound if the task was canceled by the
user.

Task failed — Play the sound at the emergency task close-down.

Sound
D Task start
Task flnlShEd successfull_l,l
------- =] RERDR 20005FOR Tupalesy!
D Task canceled b uzer
T ask failed

\DremasOk.

Figure 61. Sound setup

6.2.3.4.2. Color setup

The Kaspersky AV Control Centre program allows you to change the interface
color setting.

[ —

Colars Change the colors of the

E=h-EL Scheme: <Standard> interface elements, as mentioned

i ana] Main window background: <FFFFFF

ja=a] Task list windaw background: <E1E154>

=:] Companent list window background: <80EZFF:
“wor ana] Ewent list window background: <COCOCO:

above, is carried out in the
Colors section (Figure 62).

Figure 62. The Colors section

To make it easy for a user to set up the colors, the application provides a
selection of standard color schemes. To choose a color scheme, go to the
Schemes list. Each scheme is characterized by the following settings:

Main window background — the application main window background
color;

Task list window background — the background color of the task list
window of the Tasks tab;

Component window background - the Components tab background
color;
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¢ Event list window background — the Tasks tab background color.

In Figure 63 below, the example of the Lilac color scheme is shown
and its settings are given.

* Kaspersky Anti-¥irus Control Centre " Kaspersky Anti-¥irus Control Centre

I;a Components | ®E Settings ok ] ] Settings
M ame o K.aspersky Anti-¥irus Cc
Pﬂua + Yerzion 4.5
- Start Kaspersky Anl oL + Language: English
Alwayps

Component listwindow backaround
Task listwindow background

Lazt events in Kazpersky &% Cantrol Centre Wainwindow background

Event list window background

Figure 63. The Liliac color scheme

6.2.3.5. The Quarantine category

You can use the Quarantine settings tree to define the anti-virus quarantine
settings. Quarantine is a special storage where suspicious and infected files
detected by Kaspersky Anti-Virus Scanner and Kaspersky Anti-Virus Monitor are
placed (see Figure 64).

For your Kaspersky Anti-Virus Scanner and Kaspersky Anti-Virus Monitor to save
files to this storage, you must check the Use quarantine box on the Options
page in the properties dialog window. When running in this mode the program
quarantines the infected files, but does not delete them from their original
location. The infected files are automatically deleted from the computer only if the
Delete option in the Kaspersky Anti-Virus Scanner and the Kaspersky Anti-Virus
Monitor settings is selected.
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Kasperzky Anti-Virus Control Centre

E Components $ Settings m

O Quarantine files on K.aspersky AY Server
& Quarantine files locally

Figure 64. The Quarantine category

Files in quarantine are stored in encoded form. This:

e reduces the risk of infection from this virus (the executable code cannot
be started without preliminary decryption);

e saves time for your anti-virus programs (files in the quarantined form are
not detected as infected).

In the future you can study the quarantined files, restore them from the
quarantine or delete them.

To quarantine the files locally, i.e. on your computer (local quarantine), select the
Quarantine files locally option button in the settings tree. For details of how to
handle quarantined files refer to the next chapter.

6.2.4. The Quarantine tab

On the Quarantine page (see Figure 65), you can see contents of the local
quarantine (for details of the local quarantine see subchapter 6.2.3.5).
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Kaspersky Anti-¥irus Control Centre

E Components
File name | Beazon | Size [in by... | Original si.. | Original date E
I TEST.COM.[kq) File quarantined by Kasper... 444 B3 Friday, &pril 12, 1996 3:2 @
*
(&)
|41 | o

Figure 65. The Quarantine page

On this page you can change the display of quarantined files and handle these
files as required. To do this, use the page’s right-click menu (see Figure 66).

Large icons
@pgﬁ— Small icons
Lf| Eutract... List
¥ Delete [v | Details

ii5h Refresh
Properties. __

Figure 66. The Quarantine page right-click menu

All the commands on the menu, except for View, can also be activated using the
appropriate tool bar buttons located at the right side of the page.

By using commands from the View sub-menu you can define the display of the
icons and the list (in table form or just file names).

@ To review the file properties, follow these steps:

1. Select the required file name from the list and press the button
or select the Properties command from the file right-click menu.

2. The file properties box will appear on your screen (information in
this box is similar to the file information displayed in the table, the
difference is that it is arranged in a more friendly way, Figure 67).
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TEST.COM_[klq] Properties E
Qriginal name: TEST.COM

Type of file: MS-D0S Application

Loeation: Cohfirts

Moved by reazon:
File: quarantined by Kazpersky A% Monitar because of wirus ;l

detection
Modified: Friday, &pril 12, 1936, 3:20:00 AM
Qriginal size: B8 bytes
Encrypted size: 444 bytex

Figure 67. The file properties box

To update the list of quarantined files, select the Refresh command from the

right-click menu or press the @ button.

@ To restore a file from the quarantine, follow these steps:

1. Select the file from the list of quarantined files and press the L’I
button at the right side of the frame or select the Extract command
from the file right-click menu.

2. In the file restoration wizard box on your screen (Figure 68) press

']
the E‘ button to define the target folder where the restored file will
be placed.

Check the Decrypt box.
4. Press the Next button.

5. The restoration progress box will appear on your screen. When the
file is restored press the Finish button.
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®

Extract files from Quarantine Wizard EHE
Target folder b

Select target folder

Target folder:

< Black I Mest » I Cancel | Help |

Figure 68. The file restoration wizard box

To delete a file from the quarantine, follow these steps:

Select it from the list of quarantined files and press the X button
or select the Delete command from the file right-click menu.

The deletion confirmation box will appear on your screen. Press
the Yes button to confirm the operation.

The program will only delete the file from the quarantine but not
from its original location. The file may be automatically deleted from
its original location only if you preset the anti-virus programs on the
computer to delete infected files (selected the Delete option).

To add a file to the quarantine, follow these steps:

Press the button Ei' or select the Add command from the right-
click menu. The file quarantine wizard box will appear on your
screen (Figure 69).

Define the file to be quarantined by pressing the E button and
selecting the required file in the MS Windows standard dialog box.

If required, edit the text in the Reason field and press the Next
button.

The quarantining progress box will appear on your screen. When
the file is quarantined press the Finish button.
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RQuarantine file Wizard HE

Select file
Select file to quarantine

File to quarantine:

Reazon:

File quarantined by user

quEQ“

< Back I Mest > I Cancel | Help

Figure 69. The file quarantine wizard box

6.3. New Task Wizard

The scheduled execution of a specified application with predefined settings can
be defined as a named task of the task planner.

The New Task Wizard is activated when you select New Task in the context

amn

menu or click on the *+* button on the taskbar, the Tasks or Components tabs.

New task creation in the Kaspersky AV Control Centre is designed as a Windows
Wizard with a sequence of windows (steps), each of which is used for execution
of a specified action.

To change windows, click the Next (one step forward) and Back (one step
backward) buttons. To terminate the process, click the Finish button. To cancel
the new task creation, click Cancel. To get operation help on each step, click
Help.

6.3.1. Tasks window

In accordance with the task type, running applications or settings features, tasks
can be divided into two groups:

o tasks which launch Kaspersky Anti-Virus applications during running;
e other tasks.

Type the task name and type in the Task window (Figure 70).
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Task

Mame new tazk and select itz type from the list.

Task type:

|@ Memory and disks scanningyComponent: Kaspersky Anti-Viru_.. J

< Back I Mest » I Eirizh | Cancel Help |

Figure 70. Task window

There are the following task types:

memory and disks scanning — launches Kaspersky AV Scanner with
the individual settings feature for different scan parameters for each task.
Task launch can be scheduled to activate automatically, at a certain event
occurrence, or on direct command of a user;

real-time scanning — launches the Kaspersky Anti-Virus Monitor and/or
makes temporal modifications of its settings without reboot. The start-up
period for each setting can be strictly specified in accordance with a
schedule, determined by the occurrence of some system event, or be
specified by the user during the switch to a different activity (for example,
during new software installation, importing programs and document
copying, e-mail reception and so on);

anti-virus database update — automated database update for new
information on new viruses. You can update from the Internet, as well as
from a LAN — which reduces connection expenditures, speeds up the
update process and makes it easy to administer your package;

run user program — any application, which can be launched from the
Kaspersky AV Control Centre;

new product installation — Windows Application Setup Wizard start-up.
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6.3.2. The Schedule window for a
Kaspersky AV Monitor task

Schedule
Schedule new task

T Always
& interval

» Start | Manually

[ ] Stop | Manually

Figure 71. Schedule window for the
Kaspersky Anti-Virus Monitor task

When creating a Kaspersky Anti-
Virus Monitor task in the Schedule
window (Figure 71) you should set
the launch and pause intervals. To
launch a task at the Kaspersky AV
Control Centre start, select Always.
To set a work interval, select Interval,
then set up the launch and halt
schedule. To set up the application
launch, click on the Start button. You
will see an activated window similar
to the Schedule window for the
Kaspersky Anti-Virus Scanner task
(read further for a description of this
window).

Clicking on the Pause button will pause the task setup.

6.3.3. The Schedule window for Kaspersky
AV Scanner and Updater

When creating a Kaspersky Anti-Virus Scanner task in the Schedule window, you
should set the conditions and frequency of the launch (Figure 72).

There are the following launch options:

e On event — the task launches on the occurrence of an event or by user
command (See subchapter 6.3.3.1).

e By condition — the task launches at the occurrence of a certain task type
close-down condition (See subchapter 6.3.3.2).

e Hourly — the task launches at a scheduled time with an hourly interval

(See subchapter 6.3.3.3).

o Daily - the task launches every day at a scheduled time (See subchapter

6.3.3.4).

o Weekly — the task launches every week at a scheduled day and time

(See subchapter 6.3.3.5).
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e Monthly — the task launches on scheduled days and times (See
subchapter 6.3.3.6).

Select the required start option in the left part of the window then set up the
schedule according to details described in the subchapters below.

' Mew Task
Schedule
Schedule new task
€ Onsvert @@@ [Tme |z
" By condition (D 3:404M 1
0 7
o
o Ll )2 ><_
" Daily
IR
[° %)
< Back I Mext > I Finizh Cancel Help

Figure 72. The Schedule window for Kaspersky AV Scanner and Kaspersky AV Updater

6.3.3.1. Launching on event
The Kaspersky AV Control Centre allows you to set the task launch on
occurrence of a certain system event, or by user command.

To select this launch option, point to On event, then in the right part of the
Schedule window you will see the condition list (Figure 73).

Select a launch condition from the list. There are several options available:

Manually The task is launched manually from the Kaspersky
AV Control Centre by user command;

At Control Center start  The task is launched at the Kaspersky AV Control
Centre start, i.e., in fact at the user log in;
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At Control Center The task is launched at the Kaspersky AV Control
system service start Centre System Service start-up, i.e., in fact, at
system boot.

*'  New Task [_ [O] x|
Schedule e
Schedule new tazk

& On event Start task

" By condition

" Hourly

' Daly ™| Grice penday

 weekly

' Manthly

< Back I et > I Firiizh Cancel Help

Figure 73. Start on event setup

You can schedule any of your task types to be launched once a day or on each
occurrence of the event.

6.3.3.2. Launching by condition

The Kaspersky AV Control Centre allows you to set the task launch on the
occurrence of specified conditions related to the results of the work of some
package components.

In this product version this is realized in the following way: the user can create a
task which will be launched provided that Kaspersky Anti-Virus closes down with
a certain return code.



Kaspersky Anti-Virus Control Centre 100

* New Task

Schedule

Schedule new task

To select this
option, position the
selector in the left
part of the

© Onevent e &l Schedule screen to

@ qu‘!-m"r-é finished with exit code lﬁ BFy 74 Cond|t|0n
igure .

' Hourlp ( 9 )

' Daily

" weekly

= Manthly

< Back I Next » I FEinish | Cancel | Help

Figure 74. Start by condition setup

After doing so, in the If task window select the task status in respect to which the
condition will be formulated, and in the finished with exit code list select the task
closedown value.

Let's name the task status in respect to which the condition is formulated the
main task, and the main task closedown value the main task result.

There are the following types of main task:
e Start Kaspersky AV Monitor;
e Update anti-virus databases;
e Start Kaspersky AV Scanner.
The program processes the following main task results:

e Any- the created task will run immediately after the main task execution
without regard to its result;

e Done - the created task will run only if the main task has been
successfully accomplished;

¢ Failed — the created task will run only in case of the main task failure;

e Canceled — the created task will run only if the user canceled the main
task.

Sometimes viruses can affect the Kaspersky Anti-Virus Monitor. In this case you
should delete the viruses by other means.

By using this tab you can create, for example, a task that will automatically start
your Kaspersky AV Scanner if your Kaspersky AV Monitor has generated a start
error.
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6.3.3.3. Launching hourly

' New Task

Schedule

Schedule new task

" On event Minute:
" By condition |25l
" Houly

Figure 75. Start the task every hour

6.3.3.4. Launching daily

¥ Hew Task

Schedule
Schedule new task

¢ On event

" By condition D) 3:40 AM
£33 10:40 PM

 Houly

© B

Figure 76. Start the task every day

To launch a created task on an
hourly schedule, select the
Hourly option in the left part of
the Schedule window (Figure
75), then specify the launch time
in the right part of the window.

Figure 75 illustrates the setup of
the task launch on an hourly
basis within a 25 minutes period.
For example, if it's 12 a.m., the
task will be launched at 12:25,
13:25, 14:25 and so on.

To start the task on a daily
basis at a scheduled time,
select the Daily option in the
Schedule window (Figure
76), then set up the launch
time.

The launch time setup is
done in the Time list. Use
the Kaspersky AV Control
Centre and the context
menu for this purpose. You
can use these as follows:

Toolbar | Context menu | Purpose
button option
) Create... Creates a new launch time record. When you

select this option and the Time window is
activated, you must type in the task launch time.
You can display this window by double clicking
with your mouse in any white place within the
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Toolbar
button

Context menu
option

Purpose

Time list or by pressing the <INs> key.

Modify...

Modifies the task launch time value. When you
enable this option and the Time window is
activated, type in the modified time value. You
can also do this by double clicking with your
mouse on the line to be modified, or by pressing
the <SPACE> key.

Delete...

Deletes the task launch time record from the list.
You can also do this by pressing the <DEL> key
when on the line to be deleted.

6.3.3.5. Launching weekly

Schedule

Schedule new task.

To launch a task on a weekly basis on a
scheduled day and time enable the
Weekly option in the Schedule window,

" Onevent

= By condition

 Houly
 Daily

& Weskly
© Morthly

Figure 77. Start the task every week

then specify the days and hours of the task

" o CrTTTE— launch in the right part of the window.
v kion ey D 1040PM —
sty * To specify the dates and hours for the task

[~ ‘wednesday
I Thursdap
[V Fiidayi

I~ Saturday

launch, checkmark the days of the week,
then type in the time in the Time window .
See subchapter 6.3.3.4 for more detail on
how to specify the time.

Figure 77 illustrates the setup of a task launch on Monday (3:40 a.m. and 10:40
p.m.) and on Friday (3:40 a.m. and 10:40 p.m.).

6.3.3.6. Launching monthly

To set up the task to be started each month on scheduled days and times, select
the Monthly option on the Schedule tab (Figure 78).
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¥ New Task Jcd I =]
iy,

Schedule

Schedule new task

" On event e %
By condition T3 340 M o

(D 10:40 PM
" Haurly - *
" Daily @

T wheekly
5

NCENNNEN
\=lafi sl 2l =]
e 2=l 3 =]
TREErEN

< Back I Mest > I FEinigh | Cancel Help

Figure 78. Start the task every month

Then, use your mouse to check the dates when the created task will be launched
and specify the launch time in the Time tab (See subchapter 6.3.3.4 for more
information on how to specify the time in the list).

The task launch days are checked J Figure 78 illustrates the
settings of the created task launch on the 1st, 3rd, 13th and 30th of
each month at 3:40 a.m. and 10:40 p.m.
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6.3.4. The Al/erts window

' New Task In the Alerts window (Figure 79)
Alerts check the alert types to be
Select ypes of alerts generated during tazk execution. created by the task.

As has been mentioned above,
alerts are messages generated
Aletts by tasks.

Infected object found
Importance: critical To select an alert, check the

appropriate box.

&

Object deleted
Importance: critical

&

Intected object cured
4 Importance: high

Suspicious _uhiec:l found
[ Importance: high
Warning

Importance: informational

10 error
Impartance: infarmational

Figure 79. Alert types selection

6.3.5. The User account window

The Kaspersky AV Control Centre can be launched as a Windows system
service before login. In this case define the user account to be used by the task.

The user account contains information about the user (such as full name,
password and more).

To configure the account, go to the User account window (Figure 80).
You can use the following accounts:

Local system Windows account
account

Currently logged The current user account
on user account
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This account Account of the user whose settings are specified in the
lines Username, Password and Confirm password.

If the task is to be started under an account that is different from the current one,
the messages it generates will be screened only if you check the Allow task to
interact with desktop box.

' Mew Task

User account
Diefine uzer accaunt under which the task will log aninta a
system.

" Local System account
€ Currently logged on user account

¥ Thiz account:
Uszer name:
Jack

Pazzward:

LConfirm pazzwond;

v Allow tazk to interact with desktop

< Back I Hest » I Finizh Cancel Help

Figure 80. User account login for task start

6.3.6. Task settings

At this phase of task creation set up the task parameters specific for this type of
task. As a rule, the contents of these settings are equivalent to the tabs.

Let's take a look at task types and windows that are activated during this phase:

Task type Windows Description
sequence

Kaspersky Anti- | 1. Objects See subchapter 3.3.1
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Task type Windows Description
sequence

Virus Scanner and

Kaspersky Anti- 2. Options See subchapter 3.3.23.3.2
Virus Monitor
launch task 3. Customize See subchapter 3.3.3

Kaspersky Anti- | 1. Connecting See description in subchapter 5.2.2.
Virus Updater There are two additional options in this
window, which allow you to enable anti-
virus database and executable module
installation to the specified folder on
the Kaspersky AV Server.

2. Options See subchapter 5.2.3.

6.3.6.1. The Seftings window for Kaspersky AV
Scanner and Monitor tasks

Options in the Settings window for the Kaspersky AV Scanner task are similar to
those in the Settings window of Kaspersky Anti-Virus Scanner (for details refer
to subchapter 3.3.2).

S Statigtic refreshing type

= [ On timer

- B Timeout value [zec] <5
El On event

o[zl Ewent categary <Critical event:

Figure 81. The Settings window for the Kaspersky Anti-Virus Scanner task

The exception is the element Statistics refreshing (Figure 81) where the order
is set for a statistics update in the Report Viewer component.

Statistics can be updated by the timer (check the On timer box in the Customize
window and specify the update interval in seconds) and at the occurrence of a
system event (check the On event box, then select the event type). In this
product version you can update the statistics on critical and other events.




CHAPTER 7. KASPERSKY
REPORT VIEWER

Kaspersky Report Viewer is a program allowing you to display and manage
reports generated by Kaspersky Anti-Virus package components.

Kaspersky Report Viewer is activated by selecting the Show Report option in
the Kaspersky AV Scanner, AV Monitor main windows, and by clicking the
Report button in the Finish boxes of the Kaspersky AV Updater main window.

The Kaspersky Report Viewer main window (Figure 82) contains the following
items:

e menu;
e tool bar;

e list of sessions within the current file (you can open only one report file
at a time!);

e report table;
e status bar.

To view a session report, select the required session in the left hierarchy in the
window. The appropriate report will be displayed in the right frame.

The report table contains the following titles:
¢ Object- object handled;
¢ Result — performance result;

e Description — description of the action performed to this object.

B8 Start Kaspersky Anti-Virus Scanner - C:\Program Files\Kaspersky Lab\Kaspersky Anti-Virus Personal Pro\Report\avp3... [H[=] E3
File Edit View Help

BRI Y = L

X | Obiject | Result ‘ Description
5 Fiters I CWInTEST.COM Infected EICAR TestFile
E1-[E] Entire report C:AMIBTEST COM Quarantined | EICAR-TestFils
. [El [Thursday. October 11,
iy" Custom fiters
KN — i

|Ful Help. press F1

N

Figure 82. The report window
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To the right of the report contents you can see the tool bar, which contains
buttons for operation execution. The buttons have pop-up prompts. To see them,
point the mouse cursor to a button; next to it you will see a small window with a

short help line.

On the top you will see the main menu. We should note that taskbar buttons and
some menu commands duplicate each other.

Below, there is a comparative table of buttons and menu commands. We will
explain their purposes:

Toolbar Menu commands Function
button
e View—>Always on top | Sets the program main window to
overlay all other windows on your
Windows desktop.
u
= File=>Open Allows you to open a selected
report file.
File> Allows you to save the report into a
Save As... file with a name different from the
current one.
s File> Allows you to clear a selected
Purge report file.
% File>Print Prints
@ View->Reload Reloads the report from the
corresponding file.
#h Edit>Find Allows you to search for a user-

defined string or its part in the
report. If you press this button, the
appropriate search dialog box will
appear on your screen (see below)

Edit=>Find next

Moves to the next string meeting
the same search criteria (see
above).
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Toolbar Menu commands Function
button
View->Autotracking Allows you to track the report (if you
press this button (i.e. enable this
mode) the report will be
automatically placed on the last
line, after new data is collected).
E View->View last | Displays a report about the last
session session.
- View>View statistics | Displays only statistics
only
@' View->Comments Displays comments
Find in report [x] The Find in report dialog
box (Figure 83) appears in
String to find:

the report window when you

fl
™ Match whole word only

[ Match case
™ Match whale sting

press the 4 toolbar button
or select the Find command
in the Edit menu. To search
for a string (or its part), enter

ok I Cancel | Help

| it in the String to find text

field, define the required

Figure 83. The Find in report dialog box

The dialog box contains the following check

search criteria and press the
OK button.

boxes:

e Match whole word only — check this box to search only for complete

words matching the defined sample;

e Match case — check this box to search only for text with the specified

capitalization;

¢ Match whole string — check this box to search only for complete strings

matching the defined sample.

To exit the dialog box press the Cancel button, and to display the Help topics

window press the Help button.
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When the search function detect the first string (or the string part)
matching the predefined search criteria, you can move to the next string

meeting the same criteria by pressing the ﬂ toolbar button or
selecting the Find next command from the Edit menu.



CHAPTER 8. THE SETTINGS
TREE

The Kaspersky Anti-Virus interface frequently uses the so-called settings tree
which presents data in the form of a tree and conventional controls as joints
(buttons, drop-down lists, check boxes and etc.).

This technology provides a clear and easy to understand picture of interrelations
between various settings, and makes it easy to study the program.

In this book all controls are illustrated by pictures, so you can see how
they look like in the program windows.

8.1. The Settings Tree

Every joint in this tree may have branches. If a branch is visible the

corresponding joint looks like this: EI if the branch is hidden the corresponding
joint will change to = .
To change a setting you must make its branch visible.

To display and hide a branch you must use the following methods:

What to do How it might be done (By using...)

To display a branch —
. . E- the key on your keyboard.
(the joint looks like = )

%= Expand Mode
the

click menu.

command of the right-

The <+> key on your keypad (all branches of the
joint become visible).
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What to do How it might be done (By using...)

To hide a branch —
: the key on your keyboard.

(the joint looks like © )
the 2= Collapse Mode

command of the right-
click menu .

the <—> key on your keypad (all branches of the
joint disappear from your screen).

8.2. Controls

To change settings you will use several types of controls:

8.2.1. Check box

A box may be

L1 Al files — unchecked, meaning that this type of virus check will not be
performed.

All fles_ checked, meaning that the program will perform this type of
virus check.

To check and uncheck a box you must use the following methods:

What to do How it might be done (By using...)

To check the | the <SPACE> key on your keyboard.

box
the [4 Check command of the right-click menu .

your mouse to click on it.

To uncheck | the <SPACE> key on your keyboard.
the box
the O Uncheck

|command of the right-click menu .

your mouse to click on it.
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8.2.2. Option button

The option buttons are members of a group. A group of option buttons may
consist of two or more buttons. You must use this group to select one of the
options. The option button may be:

Q Int13h _ selected (enabled);
@ Int13h _ yeselected (disabled);

You can select only one option button from the group.

To select and deselect an option button you must use the following methods:

What to do How it might be done (By using...)

To select the option | the <SPACE> key on your keyboard.

button
the [4 Check command of the right-click menu .

your mouse to click on it.

To deselect the | By selecting another option button from the group.
option button

8.2.3. Text field

To edit value of a text field you must use your keyboard. You may see the text
field’s current value enclosed with angle brackets at the right of the field name.

Table fles baze name <KAVITAB: _ ho text field.

To edit a text field value use the following methods:

What to do How it might be done (By using...)

To edit the field | your mouse to click on the field icon.

value -
the Modiy command of the right-click menu .

the F2 key on your keyboard. The text field will change
its appearance to RAVITAB .
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After you finish editing the text field value press the Enter key on your keyboard
or click with your mouse outside of this text field. You can cancel changes this
text field and return to the previous value by pressing the Esc key on your
keyboard.

8.2.4. Input field defining the path to...

To edit value of the path field you must use the conventional Windows dialog to
select the directory or file.

zxe| Table files location <> _ the path input field.

To edit a path field value use the following methods:

What to do How it might be done (By using...)

To edit the field | your mouse to click on the field icon.

value _
the Medify command of the right-click menu .

the F2 key on your keyboard.

8.2.5. Input field defining the number of ...

To input a new value in the number field you must type it in from your keyboard
or use the cursor control keys to change the current value. You may see the
field’s current value enclosed with angle brackets at the right of the field name.

‘B! Dangerous number of files with similar size change <4>  _ the number input field.

To edit a number in the field use the following methods:

What to do How it might be done (By using...)

To edit the field | your mouse to click on the field icon.

value -
the Modiy command of the right-click menu .

the F2 key on your keyboard.

If the first character of the entered number is zero, the program
interprets it as an octal notation and translates into the corresponding
decimal number.
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8.2.6. Drop-down list

The drop-down list allows you to select one of the items from the list (Figure 84).
To browse the list you must use the T and l keys on your keyboard. To

automatically scroll down/up the list you must use the CTRL + and CTRL +

KEY COMBINATIONS.
B [Marmal vI

Figure 84. Drop-down list
8.3. Checkboxes

=-E B My computer When setting your anti-virus to check

for viruses in the disk hierarchy (see

subchapter 0) you must use the so-

called Rules of Succession, i.e. if you

define some settings for the My

Figure 85. Disk hierarchy Computer item (Figure 85), they will
be automatically assigned for all disks
on your computer.

Every item of the hierarchy is associated with a check box (that can be checked
or unchecked) and rules (applied to this item). A check box indicates whether the
corresponding hierarchy item must or must not be checked for viruses, and the
rules describe methods that will be applied when handling this item.

All the hierarchy items by default inherit rules of the group these are included in.
If you change the rules to be applied to a group, the group item rules will change
also.

You can assign independent rules to an item or change the status of its box.
These items may have independent rules. If you change the rules to be applied
to the group, these items will keep their processing rules. However, by changing
the check box status you can restore these items as inheriting the group rules.

By selecting the Set Strict command from the right-click menu you can
completely disable the rule-inheriting mode for the selected item. If you select
this command, the corresponding box will look like a red box with a black tick
inside. ltems with indicators in this condition have strictly independent rules
assigned. These items will keep their rules even after you change the group box
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status. To restore these items as inheriting the group rules, you must select the

Remove Strict command from the right-click menu.

The check box will have the following appearance:

Looks Description Meaning

like

A square with a | The check mode is enabled.
zgtarlc;‘s'crjﬁa.\y TE: g thgI sdquare is red, the inheriting mode is
red or black. Isabled.

If the square is black, the inheriting mode is
enabled.

A square with the | The inheriting mode is enabled, but some
tick inside and a | objects are excluded from the group and
triangle in the | have their own settings.
right-bottom If the triangle is red, the inheriting mode is
corner. The disabled f biect
friangle may be isabled for one or more objects.
red or black. If the triangle is black, the rule has been

changed for one or more objects.

O A square without | The check mode is disabled, but for one or

the tick and with
the triangle in the
right-bottom

corner. The
triangle may be
red or black.

more objects this mode is enabled.

If the triangle is red the inheriting mode is
disabled for one or more objects.

If the triangle is black, the rule is changed for
one or more objects.




CHAPTER 9. KASPERSKY ANTI-
VIRUS SCRIPT CHECKER

Kaspersky Anti-Virus Script Checker (Kaspersky AV Script Checker) — is an anti-
virus application that protects your computer from script viruses and worms
executed directly in the memory. When you run the Kaspersky Anti-Virus for
Workstation setup utility, the program is automatically added in your operating
system and later you will not have to start it manually.

Different programs that use Microsoft Windows Script Host (e.g., Microsoft
Explorer, Microsoft Internet Explorer, Microsoft Outlook and others) send scripts
(such as VB Script and Java Script) to Script Hosting for processing and further
execution. Before executing these script files, Kaspersky AV Script Checker
sends them to the Kaspersky Anti-Virus Monitor for checking (provided that it is
installed and launched) and, if Monitor doesn’t detect viruses, carries out an
heuristic analysis® of the script file code. If a file is suspicious, Kaspersky AV
Script Checker sends a message and prohibits execution of the script.

Kaspersky AV Script Checker does not use the anti-virus databases.

The anti-virus databases are used by Kaspersky AV Scanner and
Kaspersky AV Monitor. The advantage of the Kaspersky AV Script
Checker in comparison to other anti-virus applications is that it warns
the user of a possible infection by a new virus, which is not yet defined
in the anti-virus databases.
Script files in Windows are executed in memory without any preliminary
call to the disk. Therefore, such protection tools as Kaspersky Anti-
Virus Monitor can’t check script files before their execution. Script
Checker intercepts the execution of script files and sends them to
Kaspersky Anti-Virus Monitor to be checked. In that way Kaspersky AV
Script Checker in combination with Kaspersky Anti-Virus Monitor offers
full protection from all virus types.

Let' study a situation in which Kaspersky AV Script Checker protects your
computer from a virus.

® Heuristic analysis — analysis of the succession of commands in the checked object,
collection of statistics, and determination as "possibly infected" or "not infected” (See
www.viruslist.com for further information).



The Settings Tree 118

Let's imagine that you go to a web site containing a script virus similar to
LoveLetter®. If your Internet browser has low-level protection, the script virus will
be immediately executed, but Kaspersky AV Script Checker will prevent the
execution of the infected script and protect your computer from the virus attack.
Kaspersky AV Script Checker will send a warning like that shown below (Figure
86):

KAY Scnpt Checker.Suzpicion: |-'wWorm S5cnpt detected! |

Languags ~ WBScrpt KAJPIR{KY 2
Application: Do IMM T WS pstem 323w S oript, exe

Soript execution was denied due to the suspiocion on |-Worm, S cript

Bermit |

Figure 86. Warning about a possible virus

4 Lovel etter is adangerous Internet worm that led to mass computer infection in May,
2000. The worm was spread by e-mail messages. When activated it would send itself to
all addresses stored in the Microsoft Outlook address book (see www.viruslist.com for
more detail).



CHAPTER 10. KASPERSKY ANTI-
VIRUS RESCUE DISKS

Kaspersky Anti-Virus includes Kaspersky Anti-Virus Rescue Disk, a special
program allowing you to create a set of fallback-recovery disks.

The fallback-recovery (or rescue) disks are used for system recovery after a virus
attack. These disks include:

e system files of the Linux operating system;
e anti-virus scanner;
e anti-virus databases.

The rescue disks work on the following principle. Let's imagine that as a result of
a virus attack your computer is not capable of initial boot. In this case you have
to boot your computer using a bootable disk from the fallback set. The bootable
disk will load the Linux operating system, then start the anti-virus scanner. When
required, the load program will prompt for disks with the anti-virus bases. If
detected a virus the anti-virus scanner will ask for instructions on how to handle
it: to remove the virus from the file, to delete the infected file or to log the event.

10.1. Creating a Fallback-Recovery
Set

To start your rescue disk creation program, Kaspersky Anti-Virus Rescue Disk,
go to the Windows main menu and select Kaspersky Anti-Virus Rescue Disk
from the Kaspersky Anti-Virus program group. The Welcome box, the first wizard
box, will appear on your screen (Figure 87). To move to the next wizard box you
should press the Next button in the current box.
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E_ Kaszpersky Anti-¥iruzs Rescue Dizsk [ 2]

=

Welcome to Kaspersky Rescue Disk
Wizard

Thig wizard will guide you through creating process

To continue, click Nest

< Back Cancel |

Figure 87. The Welcome to Kaspersky Rescue Disk wizard box

The Configuration wizard box (Figure 88) allows you to specify the fallback
recovery disks to be created:

Bootable disk containing executable files — boot disk with Linux OS files
and the Kaspersky Anti-Virus executable files.

Disks with anti-virus bases — disks with virus definitions and methods to
be used for their removal. It's advisable that you update these disks with
updated anti-virus databases on the regular basis.

The bootable disk containing Linux operating system and the

Kaspersky Anti-Virus executable files can be created only once, and the
disk with anti-virus bases must be created every time the update is
released.

The Basis options group allows you to specify how the anti-virus base disks
should be created:

®

®

Delete all files from disk before copying — removes all files from the disk
before copying anti-virus bases onto it.

Update bases when copying — copies only the updated bases onto the
disk. With this option selected the program doesn’t clean the disk before
copying bases onto it but compares bases on the disk against those to be
copied. If the bases are identical the program doesn’t copy any files onto the
disk.

If you selected the Update bases when copying option, you should

insert anti-virus base disks in the order, in which these were created.
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'.n. Kaspersky Anti-Yirus Rescue Disk EE
Configuration

Specify disks you want to include in the rescue disk.

'ou cah include the following disk types in the rescue disk:

-bootable dizk containing Linux operating system and KA executable files;
-dizks with anti-viruz bazes containig virus definitions.

K.eep your dizks with anti-virug bazes up-to-date.

Dizks to create:
¥ Bactable disk caontaining executable files

B azes options
& Delete all files from disk before copying

€ Update bages when copying

< Back I Mest > I Cancel

Figure 88. The Configuration wizard box

In the next wizard box, the Anti-Virus Bases box (Figure 89), you must define
path to the file AVP.SET. This file is included in the Kaspersky Anti-Virus
package and contains the list of available anti-virus databases.

E_Kaspelsk_v Anti-Yirus Rescue Disk

Anti-Virus Bases
Specify the folder that containg the K& SET file.

AVP.SET file includes anti-vinus bases list. Y'ou have to specify folder that containg thiz file.

Folder:

C:AProgram FileshCommon FileshKAY Shared FileshB azes E’:l

< Back I Mext > I i Cancel |

Figure 89. The Anti-Virus Bases wizard box

In the Destination box (Figure 90), you must select the logical drive, where the
files will be copied.
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"u_ Kaspersky Anti-¥irus Rescue Disk

Destination
Select drive for the rescue disks you want to create.

Drivve:

At

< Back I Mext » I i LCancel I

Figure 90. The Destination wizard box

The program will then copy the files to the defined logical drive (Figure 91).
During the copying process the application may prompt for additional disks.

3/ Kaspersky Anti-Vius Rescue Disk

Copying files. ..

Flease wait until program completes operation.

Copying files...

C:%Prograrn Files\K.azpersky Lab\K azpersky Antivirus Perzonal Pro\boaotdizk.img

< Bach Firirsfy

Figure 91. The Copying files wizard box

When the files are copied to the disks, you will see the Completing wizard box
(Figure 92). This means that the rescue-disk creation program has accomplished
its task.
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irus Aescue Disk HE

Completing the Rescue Disk Wizard

r'ou have successfully completed the Rescue Disk Wizard.

To cloze this wizard, click Finish. To create anather set click Back
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Figure 92. The Completing the Rescue Disk Wizard box

10.2. Using the Fallback-Recovery

Disks

To use the fallback-recovery set, it is advisable that you follow these steps:

1.

Insert the start-up fallback-recovery diskette into the floppy disk drive
and restart your computer. When the operating system is loaded, the
anti-virus scanner will start checking for viruses in boot records and the
master boot record on your computer. If it detects a virus, the program
will automatically delete it. Then the program will screen a prompt
similar to the following:

Please select a device for swapping.

N ..

1. /dev/ide/host0/bus0/target0/lunl/part 1

2. /dev/ide/host0/bus0/target0/lun0/part 5

0. No swap (Recommended)

Please enter the preferred partition number and
press ENTER.

You must select the drive where the operating system
will create temporary files and enter its number.
File names are displayed in the Linux format. After
that, the program will prompt for the drive where the
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report file will be created. The prompt will look
similar to the above.

Note that details of your computer disk names with the Linux OS format
appear on your screen above the request for temporary data disk. You
will need these disk names later, when you decide to start your anti-
virus on your own. The data format is:

Remounting root filesystem in read-write mode.

/dev/ide/host0/busO/target0/lun0/partl (Vfat) has
been mounted to /mnt/diskl

It is not recommended to use the fallback-recovery diskettes in the
NTFS file system. If the device type is defined as ntfs, you should not
select this device or start your anti-virus scanner to check and delete
viruses on it.

When prompted, insert the appropriate disk from the fallback-recovery
set. When the anti-virus base files are copied from the diskette you
should replace it and press the <ENTEr> key three times in order to
proceed with the operation. After this, the program will start scanning for
viruses on your computer.

When detected a virus the program displays the query of the following
format:

File <filename > Infected by virus:<virus name>
Actions - Report only (Ok,
disInfect/Delete/Cancel/Stop)

where:

<filename> is the name of infected file,

<virus_name> is the name of detected virus. By entering one of the
following characters you may select how the program should handle
the infected file:

O or nothing — log the virus details,

| — attempt to disinfect the file,

D — delete the infected file,

C —ignore the file,

S — interrupt the scanning operation.

4. After this the program will prompt you whether you want to apply the

selected action to all the infected files detected later:

Apply to all infected objects? - Yes/No

To respond to this query enter one of the following characters:

Y — apply the selected action to all the infected files detected later,
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N — display the same query as above whenever an infected file is
detected

5. After the scanning operation is finished the statistics table appears on
your screen. Study the statistics and press the <ENTER> key.

e Sector objects — sectors processed;

e Files —files processed;

e Folders — folders processed;

e Archives — archives processed;

o Packed — packed executable objects processed;
e Known viruses — known viruses detected;

e Viruses bodies — virus bodies detected;

o Disinfected — objects disinfected;

o Deleted — objects deleted;

e Warnings — warnings generated;

e Suspicious — suspicious objects detected;

e Corrupted — corrupted files detected;

e 1/O errors — input/output errors occurred.

o Speed (Kb/sec) — the average speed of scanning in Kb/sec.
e Scan time - the total time of scanning.

6. The menu of ulterior actions will appear on your screen:

1: Run kavscanner

2: See config
3: See report
4: Exit

Your choice [1,2,3,41>
Enter the digit that corresponds to your choice:

1 — start the anti-virus scanner again. If you enter this digit the
following prompt will appear on your screen:

Enter directories for scanning>

Enter the directories to be scanned using the Linux OS format and
make sure to separate them by spaces. For example, the disk C:
directory called work may look similar to the following in the Linux OS
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notation: /mnt/diskl/work. The disk names appear on your screen
after you use the first disk from the fallback-recovery set (see above).

After you enter the directories the program will start prompting for
anti-virus base disks, and after this it will start scanning in the
selected location.

2 — display the anti-virus scanner profile.
3 — display results of the last scanning session.
4 — exit the program.

7. After the scanner has finished scanning and disinfecting, press the key
combination <CTRL>+<ALT>+<DEL> to reboot your computer and
remove the rescue disk from the floppy disk drive.



CHAPTER 11. KASPERSKY ANTI-
VIRUS MAIL CHECKER

Kaspersky Anti-Virus Mail Checker for Microsoft Exchange Client Compatibles
(Kaspersky AV Mail Checker) is designed to protect users’ computers from
viruses that use Microsoft Outlook 98/2000/XP for sending and receiving mails.

& The current version of Kaspersky AV Mail Checker is not compatible
with Outlook Express and TheBat!
The Kaspersky AV Mail Checker program performs the following functions:

e Checks for viruses in all, the incoming and outgoing messages. The
program checks messages right after these arrived or were sent and it
searches for viruses in both message bodies and attached files.

Kaspersky AV Mai Checker also searches for viruses within embedded
archives, packed executable files, plain mail files and mail databases.

e Checks for viruses in the messages stored in the local mailbox before the
Kaspersky AV Mail Checker program was installed. These messages are
checked when the user opens them.

e Allows the user to disinfect infected attached files.

o Kaspersky AV Mail Checker deletes infected objects from messages and,
if all elements of the message are infected, it deletes the entire message.

The anti-virus settings are defined from the program that is used for mail
processing.

While handling mounted mailboxes the program implements limited
features: it doesn’t check messages when these arrive to such
mailboxes. The messages are checked only when the user opens these
messages.

11.1. Configuring Kaspersky AV Mail
Checker

The recipient protection settings can be displayed and redefined on the
Kaspersky Anti-Virus MailChecker page of the Options dialog window that
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can be displayed from the mail-processing program Microsoft Outlook
98/2000/XP.

@ To display the Options dialog window from Microsoft Outlook:

1.  Start Microsoft Outlook;

2. Select Options from the Tools menu;

3. Switch to the Kaspersky Anti-Virus MailChecker tab.
On the Kaspersky Anti-Virus MailChecker tab (Figure 93), you can:

e Enable or disable the anti-virus otection of your incoming or outgoing
mail by checking/unchecking the ¥l Enable Protection box;

e Set the program to display an alert message when your mail client is
trying to send an infected message by checking/unchecking the ¥l Popup
Alert Message box upon detection box.

& Kaspersky Anti-Virus Mail Checker integrated into this version of
Kaspersky Anti-Virus for Workstation does not allow you to employ a
unified approach to handling infected messages

21

Freferences I Mail Services | td il Format | Spelling
Security I Other F.azpersky Anti-virug M ail Checker | Delegates

— General Settings

V¥ Popup Alert Message box upon detection
" Sendreport to sender of message

" Sendreport to address:

Iadmin@ynurdomain

Help | Advanced Options... |

Ok I Cancel | Apnly

Figure 93. The Options dialog window with the Kaspersky Anti-Virus MailChecker tab
displayed
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11.2. Running Kaspersky Mail
Checker

Right after installed Kaspersky AV Mail Checker will start to display alert
messages. However, you will see these alerts only when the virus is detected in
your outgoing message (if you have checked the ¥l Popup Alert Message box
upon detection).

Below, we describe several differences in the ways Kaspersky AV Mail Checker
treats incoming and outgoing mail traffic:

11.2.1. Incoming messages

Incoming messages are checked automatically right after these arrive to the
protected mailbox. If these messages are clean, you will receive them
immediately. However, if Kaspersky Anti-Virus finds an infected object, it will try
to disinfect it. If disinfection fails, the object will be deleted from the message. If
disinfection is successful, the message with the disinfected object will be
delivered to you immediately after treatment.

Note that the program will not notify you about disinfection / deletion of
an object from your e-mail message.

If all objects in this message are infected, you will receive this letter only if at
least one of these objects can be disinfected. Otherwise, the entire message will
be deleted.

& Note that the program will not notify you about deletion of the message.

11.2.2. Outgoing messages

Outgoing messages are checked for viruses right after the user press the Send
button. If an outgoing message is infected the program attempts to cure it (if the
appropriate option is enabled).

If the Popup Alert Message box upon detection box is unchecked the
message will be processed in background mode, which does not require any
interaction on your part. Clean messages will be sent to the recipients and
infected messages will be subjected to treatment. After treatment, the messages
will be:
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e sent, if disinfection was successful;
e sent but without infected attachments the program failed to disinfect;
o deleted if disinfection of the message or ALL the attached files failed.

If the ¥l Popup Alert Message box upon detection box is checked, you will
have to respond to the alerts:
1. If disinfection failed, the appropriate alert will appear on your
screen (Figure 94).

Kaspersky AV Mail Checker Alert x|

& The messzage You are sending contains infected attachments. Delete attachments?

Figure 94. The alert about deleting infected attachments from an outgoing message

e Press the Yes button to delete the attachment and send the
clean message to the recipient.

e Press the No button if you do not want to send this message
without the attachment. After this, the infected-message-to-be-
sent warning will appear on your screen (Figure 95). Cancel the
sending operation by pressing the No button.

Kaspersky AV Mail Checker Alert Ed

& The meszage v'ou are going to gend containg viluges, Send anpwayp?

] w |

Figure 95. The outgoing message is infected!

11.2.3. Messages in the mailbox

Kaspersky AV Mail Checker checks for viruses in the messages that were stored
in your mailbox before you installed this program. These messages are checked
when open them. In this case the program handles these messages as if these

just arrived to your mailbox.



APPENDIX A.

ADVANCED CHECKING
TOOLS

A.1. The Heuristic Checking Tool

(Code Analyzer)

Code Analyzer, a heuristic checking tool, checks file and sector codes down the
various Kaspersky Anti-Virus algorithmic legs as it searches for virus-similar
instructions. If the heuristic tool detects certain instructions (such as open a file,
write to it, intercept the interrupt vectors, etc.), the file is suspicious and the
program generates the appropriate message:

Suspicion: <TYPE>,

where <TYPE> is replaced by one of the following strings:

Com - the file seems to be infected by a virus that infects .COM files;
Exe — the file seems to be infected by a virus that infects .EXE files;

ComExe — the file seems to be infected by a virus that infects both .COM
and .EXE files;

ComTSR, ExeTSR, SysTSR, ComExeTSR - the file seems to be
infected by a virus that infects .COM, .EXE and .SYS files;

Boot — the file/sector seems to be infected by a boot virus or a boot virus
installer;

Trojan — the file looks like a Trojan;

Trivial — the file seems to be infected by an unknown virus replacing
executable files in a current directory by its own codes (usually the virus
size doesn’t exceed 300 bytes);

HLL - the file seems to be infected by an unknown virus infecting
executable files. The virus is written in a high-level language (C, Pascal);

Win32 - the file seems to be infected by an unknown Windows virus;

Formula — an Excel file contains suspicious instructions.
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¢ RemoteTemplate — the document contains a link to a template which is
automatically loaded when the file is opened;

e HTML.SecurityBreach.2 — the HTML file or the HTML message is linked
to a suspicious object;

¢ IRC-Worm.generic — the file seems to be infected by an unknown worm
transmitting itself via the IRC channels;

e BAT - the file seems to be infected with an unknown virus infecting BAT
files;

e VBS.I-'Worm - the file seems to be infected by an unknown worm
transmitting itself via e-mail.

Of course, as with any other heuristic algorithm you may occasionally receive
false alarms. However, Code Analyzer has been tested many times and has
checked a large number of files, and so far has not been deceived. If you do
encounter a false alarm while checking files using Code Analyzer, please let us
know and send us copies of the virus-free files that were identified as infected so
that we may study them at Kaspersky Labs.

When scanning code the heuristic detecting tool examines the structure of a
program down to several sub-levels. This device detects 92 % of the viruses
(including many encrypted ones) in the Kaspersky Lab’s database, and we
believe that newfound viruses that aren’t yet in the database will be detected with
the same degree of probability.

A.2. The Redundant Scanning Tool

In most cases a virus registers itself in the entry point of a file with a reference to
its body, which is usually appended to the file contents. To delete such viruses
you only need to run an ordinary scanning operation that will remove the virus
code located in the file entry point and the virus body pointed to by the initial
address.

However, sometimes the virus divides its body into several parts and places
them into clean areas of the file. In this case an ordinary scanning operation will
neutralize the virus (i.e. the virus code in the entry point and main part of the
virus body will be deleted) but some of its parts will remain in the file.

In this case you need to run a redundant scan operation that will check not only
the file entry points but also the entire contents of your file.

The redundant scanning tool is recommended if no virus was detected in a
normal scan but the system is still behaving strangely (for example, there are
frequent instances when the computer restarts by itself, unnaturally slow
performance from applications, etc.) Otherwise, we do not recommend enabling
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the redundant scanning tool as it noticeably slows down the scanning rate and
increases the probability of false alarms.



APPENDIX B. GLOSSARY

alert (notification)

An e-mail message that is automatically transmitted by a Kaspersky Anti-Virus
package component to a predefined address at the occurrence of a predefined
event (when a virus is detected, a component fails to perform its functions, etc.)

anti-virus

Computer software that is designed to protect a computer from
penetration/replication of computer viruses.

anti-virus databases

A set of files that contains descriptions of viruses and methods to remove them.
Kaspersky Labs updates these files on a daily basis by adding details of new
viruses to them; the updates are placed on the Kaspersky Labs web sites and
can be later retrieved by the updating utility.

anti-virus scanner

A computer program that allows scanning for suspicious objects on a computer
(see also Kaspersky Anti-Virus Scanner).

boot virus

A virus that occupies a boot sector of the infected diskette or a boot sector or the
master boot record of the infected hard drive. This virus forces the system (when
it is started) to read into the memory and to transfer control to the virus code
instead of the original loader. l.e. this virus infects this system every time it is
loaded using an infected source.

Code Analyzer

See heuristic checking tool

false alarm

A false claim that a file is infected by a virus is known as a “false alarm”.
heuristic checking tool (Code Analyzer)

A tool that verifies an instruction sequence in the examined object, collects
certain statistics and decides whether the object is “probably infected” or “not
infected”. This tool makes it possible to search for unknown viruses.

interface subprogram of a Kaspersky Anti-Virus package component

A sub-program that supports communication between a user and the service
sub-program.
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Kaspersky Anti-Virus Control Centre

A computer program that performs the functions of a control shell. This program
allows creation and scheduling of task performance, and also control of
performance results.

Kaspersky Anti-Virus Mail Checker

A computer program that provides protection from viruses in the incoming and
outgoing messages that are processed using a Microsoft Exchange Client
compatible software.

Kaspersky Anti-Virus Monitor (monitor)

A resident anti-virus monitor. When it detects a virus in an object the monitor
disables reference to the object and notifies the user.

Kaspersky Anti-Virus Rescue Disk

A computer program that allows the user to create rescue disks. These disks
allow a user to recover a system after it has been corrupted by a virus.

Kaspersky Anti-Virus Scanner (scanner)

A computer program that detects and deletes viruses on a computer on user
demand.

Kaspersky Anti-Virus Script Checker

A computer program that protects your computer from script-viruses and worms
that are executed directly in the computer memory.

Kaspersky Anti-Virus Updater

A computer program that allows automatic updating of anti-virus bases and
package components.

Kaspersky Report Viewer

A computer program that allows you to view and manage reports generated by
Kaspersky Anti-Virus package components.

notification
See alert
polymorphic virus

A virus which has been written in such a way as to make it harder for an anti-
virus program to recognize it. These viruses contain no constant code blocks at
all.

profile

See settings file
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quarantine

A directory containing infected and suspicious files in coded form. These files
can later be restored using Kaspersky Anti-Virus Control Centre, if they were
deleted by mistake, or in order to archive and e-mail to Kaspersky Labs where
they can be studied.

rescue disks

A set of diskettes that allows you to boot the system and check it for viruses.
They can be used to restore your system in case it has been completely disabled
as the result of a virus attack. These diskettes contain an operating system, an
anti-virus program and the anti-virus bases. They can be created using
Kaspersky Anti-Virus Rescue Disk.

resident anti-virus monitor

A memory-resident computer program that checks for viruses in the used objects
(documents to be opened, files to be saved, etc.).

scanning

A process that is performed by an anti-virus scanner when it checks for viruses in
a predefined location. A user may set the computer memory, disks, folders, etc.
as locations to be checked for viruses.

script virus

A virus which has been written in a script language. This virus usually embeds
itself in a web page and is started when this page is viewed. A message in HTML
format may also carry such viruses.

settings file (profile)

A file that contains the main settings of a program. These settings can be
exported (saved) to a file and imported (loaded) from this file. When started, the
program adopts settings from the default profile.

settings tree

A graphic interface item that presents data in the form of a tree with conventional
controls as joints (buttons, drop-down lists, check boxes, etc.)

service sub-program of a Kaspersky Anti-Virus package component

A sub-program that constantly resides in the computer memory. This sub-
program performs user-defined actions (scanning, monitoring, etc.).

stealth virus

A virus that utilizes various methods to conceal its presence in a system.
Nowadays, any class of virus can utilize stealth features.



137 Kaspersky Anti-Virus for Workstation

suspicious object

An object whose actions or contents appear similar to a virus. A memory
location, file, macro and other objects can be claimed to be suspicious.

system crack (hack)

Unauthorized access that is gained to the system’s data or resources. Systems
are frequently cracked using a malware.

Trojan

Named after the Trojan Horse of mythology, this is a class of malware that looks
as if it is a harmless program but which in fact performs destructive or undesired
actions, such as remote management, data stealing, monitoring, etc.

updating server
A server that stores the most up-to-date anti-virus bases or program modules.
virus

A computer program (that is, executable code and/or a collection of instructions)
that can replicate itself (though the copy may not necessarily exactly match the
original) and can penetrate files and other resources of computer systems and
networks and make them perform tasks the virus dictates without the user’'s
permission. Copies of the program are also capable of replicating themselves
(for more details see Virus Encyclopedia
http://www.viruslist.com/eng/viruslist.asp).

virus attack
A set of actions that are performed in order to infect a computer.
Windows virus

A virus that while infecting a file utilizes features of the Microsoft Windows
operating system.

worm

A class of malware that spreads using a computer network such as the Internet.
Worms penetrate computers from the computer network by finding computer
network addresses and dispatching their copies to these addresses. Sometimes
these viruses create work files on system disks, but they can avoid using system
resources (with the exception of RAM).


http://www.viruslist.com/eng/viruslist.asp

APPENDIX C. KASPERSKY LABS
LTD.

Kaspersky Labs is a privately-owned, international, anti-virus software-
development group of companies headquartered in Moscow (Russia), and
representative offices in the United Kingdom, United States of America, China,
France and Poland. Founded in 1997, Kaspersky Labs concentrates its efforts on
the development, marketing and distribution of leading-edge information security
technologies and computer software.

Kaspersky Labs is one the world leaders in data-security and anti-virus
technologies. The Company was the first to develop many features that are now
an essential part of all modern anti-virus protection: an external anti-virus
database with embedded specialized modules, a search capability within
archived and compressed files, integrated anti-virus protection for Linux, etc. In
addition to anti-virus software, Kaspersky Labs is committed to the development
of general data-security software. Our current product line includes Kaspersky™
Inspector and Kaspersky™ WEB Inspector, whose unique capabilities allow
users full control over any unauthorized alteration to the file system and content
of a Web server.

Upcoming add-on features include Kaspersky™ Anti-Hacker for general
workplace defense against any hacker attacks, and Kaspersky™ Anti-Spam for
enterprise-wide prevention of incoming "spam" messages and internal e-mail
misusing. Kaspersky Labs' flagship product, Kaspersky™ Anti-Virus (formerly
known as AVP), has been in constant development since 1989, and has been
rated consistently by numerous computer magazines and virus research centers
as the best anti-virus product on the market.

Kaspersky™ Anti-Virus covers all reliable methods of anti-virus protection: anti-
virus scanners, resident "on-the-fly" virus interceptors, integrity checkers and
behavior blockers. Kaspersky™ Anti-Virus supports all of the most popular
operating systems and applications. It provides strong anti-virus defense for e-
mail gateways (MS Exchange Server, Lotus Notes/ Domino, Sendmail, Qmail,
Postfix, and Exim), firewalls and WEB servers. All Kaspersky Labs products rely
on Kaspersky's own database of over 60,000 known viruses and all other types
of malicious code. The product is also powered by a unique heuristic technology
combating even future threats: the built-in heuristic code analyzer, which is able
to detect up to 92% of unknown viruses and the world's only behavior blocker for
MS Office 2000 providing 100% guaranteed protection against any macro-
viruses.



139 Kaspersky Anti-Virus for Workstation

C.1. Other Anti-Virus products

Kaspersky® Anti-Virus Lite

The program is the most easy-to-use Kaspersky Lab anti-virus product that is
developed for protection of home computers running Windows 95/98/Me,
Windows 2000/NT Workstation, Windows XP.

Kaspersky® Anti-Virus Lite includes:

e anti-virus scanner provides a comprehensive check of all local and
network drive contents on demand,;

e anti-virus monitor automatically checks in real-time all used files;

e module for checking MS Outlook Express mail databases for viruses on
demand.

Kaspersky® Anti-Hacker

Kaspersky® Anti-Hacker is a personal firewall that is designed to safeguard a
computer running a Windows operating system. It protects the computer against
unauthorized access to its data and external hacker attacks from the Internet or
an adjacent local network.

Kaspersky® Anti-Hacker monitors the TCP/IP network activity of all applications
running on your machine. If it detects any suspicious actions, the program blocks
the suspect application from accessing the network. This allows you to preserve
confidential data on your machine.

Thanks to SmartStealth™ technique it becomes more difficult to detect your
computer from outside. At the same time you will not feel any negative influence
of this mode while working on the Web: the program provides conventional
transparency and accessibility of the data.

Kaspersky® Anti-Hacker blocks the most common hacker network attacks,
monitors for attempts to scan computer ports. Software supports simplified
management by choosing one of five security levels. By default the program
starts with the self-learning mode that will automatically configure your security
system depending on your responses to various events.

Kaspersky® Security for PDA

Kaspersky® Security for PDA provides reliable virus protection for the data
stored on PDA running Palm OS or Windows CE, as well as for any information
transferred from a PC or extension card, ROM files and databases. Software
contains a combination of targeted anti-virus tools: an anti-virus scanner — used
for on-demand virus checking of all stored data (on both the PDA itself as well as
on any extension cards) and an anti-virus monitor that intercepts viruses in
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data transferred when using the HotSync™ utility or when data is beamed from
other portable devices. Kaspersky® Security for PDA also provides protection of
data stored in pocket computers (PDAs) against unauthorized access. It
supports the encrypted access to the device and encrypts all the data stored on
the device and on memory cards.

Kaspersky® Anti-Virus Business Optimal

The package has been developed to provide full-scale data-protection for small
and medium-size corporate networks.

Kaspersky® Anti-Virus Business Optimal includes full-scale anti-virus protection
for:

e workstations running Windows 95/98/ME, Windows NT/2000
Workstation, Windows XP, Linux;

o file and application servers running Windows NT/2000 Server, Linux,
Solaris, Novell NetWare, FreeBSD, BSDi, OpenBSD;

e mail gateways MS Exchange Server 5.5/2000, Lotus Notes/Domino,
Sendmail, Postfix, Qmail, Exim.

You are free to choose any of the anti-virus programs according to the operation
systems and applications you use.

Kaspersky® Corporate Suite

The package has been developed to provide the full-scale data-protection for
corporate networks of any size and complexity. The package components allow
protection of all nodes on a corporate network. The product can be ideally
integrated into your corporate network regardless of the software and hardware
from other manufacturers that you use on it. The flexibility of this anti-virus
solution allows you to create an effective data-protection system that is fully
appropriate and compatible for your network configurations.

Kaspersky® Corporate Suite includes full-scale anti-virus protection of:

e workstations running Windows 95/98/ME, Windows NT/2000
Workstation, Windows XP, Linux, OS/2;

o file and application servers running Windows NT/2000 Server, Linux,
Solaris, Novell NetWare, FreeBSD, BSDi; OpenBSD;

e mail gateways MS Exchange Server 5.5/2000, Lotus Notes/Domino,
Sendmail, Postfix; Exim, Qmail;

e  CVP compatible firewalls;
e \Web servers;

e pocket-size computers (PDA) running Palm OS or Windows CE.
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You are free to choose any of the anti-virus programs according to the operation
systems and applications you use.

Kaspersky® Anti-Spam

Kaspersky® Anti-Spam is a cutting edge software suite designed to help
organizations with small and medium size networks wage war against the
onslaught of undesired e-mail (spam). The product combines revolutionary
technology where the program linguistically analyses message text, all modern
methods of e-mail filtration (including RBL lists) and a unique collection of
services that allows users to identify and wipe out up to 95% of unwanted traffic.

Kaspersky® Anti-Spam acts as a filter installed at a network’s entrance where it
verifies incoming e-mail traffic streams for objects identified as spam. Software is
compatible with any mail system, already used in the customer company, and
can be installed both on existing mail server or dedicated one.

The high effectiveness of Kaspersky® Anti-Spam is enabled by the daily update
of content filtration database with the samples provided by the specialists of
linguistic laboratory.

C.2. Contact Information

If you have any questions, comments or suggestions please refer them to our
distributors or directly to Kaspersky Labs. We will be glad to advise you on any
matters related to our product by phone or e-mail and all your recommendations
and suggestions will be thoroughly reviewed and considered.

Technical Please find the technical support information at
support http://www.kaspersky.com/supportinter.html
General WWW: http://www.kaspersky.com
information

http://www.viruslist.com

E-mail: sales@kaspersky.com
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APPENDIX D. LICENSE
AGREEMENT

NOTICE TO ALL USERS: CAREFULLY READ THE FOLLOWING LEGAL
AGREEMENT (“AGREEMENT”), FOR THE LICENCE OF SPECIFIED
SOFTWARE (“SOFTWARE”) PRODUCED BY KASPERSKY LAB.
(“KASPERSKY LAB”).

IF YOU HAVE PURCHASED THIS SOFTWARE VIA INTERNET BY CLICKING
THE ACCEPT BUTTON, YOU (EITHER AN INDIVIDUAL OR A SINGLE
ENTITY) CONSENT TO BE BOUND BY AND BECOME A PARTY TO THIS
AGREEMENT. IF YOU DO NOT AGREE TO ALL OF THE TERMS OF THIS
AGREEMENT, CLICK THE BUTTON THAT INDICATES THAT YOU DO NOT
ACCEPT THE TERMS OF THIS AGREEMENT AND DO NOT INSTALL THE
SOFTWARE.

IF YOU HAVE PURCHASED THIS SOFTWARE ON A PHYSICAL MEDIUM,
HAVING BROKEN THE CD’S SLEEVE, YOU (EITHER AN INDIVIDUAL OR A
SINGLE ENTITY) ARE CONSENTING TO BE BOUND BY THIS AGREEMENT.
IF YOU DO NOT AGREE TO ALL OF THE TERMS OF THIS AGREEMENT DO
NOT BREAK THE CD’s SLEEVE, DOWNLOAD, INSTALL OR USE THIS
SOFTWARE. YOU MAY RETURN THIS SOFTWARE FOR A FULL REFUND.
YOUR RIGHT TO RETURN AND REFUND EXPIRES 30 DAYS AFTER
PURCHASE FROM AN AUTHORISED KASPERSKY LAB DISTRIBUTOR OR
RESELLER. THE RIGHT TO RETURN AND REFUND EXTENDS ONLY TO
THE ORIGINAL PURCHASER.

All references to “Software” herein shall be deemed to include the software
activation key (“Key Identification File”) with which you will be provided by
Kaspersky Lab as part of the Software.

1. Licence Grant. Subject to the payment of the applicable licence fees,
and subject to the terms and conditions of this Agreement, Kaspersky Lab
hereby grants to you a non-exclusive, non-transferable right to use one copy of
the specified version of the Software and the accompanying documentation (the
“‘Documentation”) for the term of this Agreement solely for your own internal
business purposes. You may install one copy of the Software on one computer,
workstation, personal digital assistant, or other electronic device for which the
Software was designed (each, a “Client Device”). If the Software is licensed as a
suite or bundle with more than one specified Software produce, this licence
applies to all such specified Software products, subject to any restrictions or
usage terms specified on the applicable price list or product packaging that apply
to any of such Software products individually.
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1.1 Use. The Software is licensed as a single product; it may not be used
on more than one Client Device or by more than one user at a time, except as
set forth in this Section.

1.1.1  The Software is “in use” on a Client Device when it is loaded into the
temporary memory (i.e., random-access memory or RAM) or installed into the
permanent memory (e.g., hard disk, CD-ROM, or other storage device) of that
Client Device. This licence authorizes you to make only as many back-up copies
of the Software as are necessary for its lawful use and solely for back-up
purposes, provided that all such copies contain all of the Software’s proprietary
notices. You will maintain records of the number and location of all copies of the
Software and Documentation and will take all reasonable precautions to protect
the Software from unauthorised copying or use.

1.1.2  If you sell the Client Device on which the Software is installed, you will
ensure that all copies of the Software have been previously deleted.

1.1.3 You shall not decompile, reverse engineer, disassemble or otherwise
reduce any party of this Software to human readable form nor permit any third
party to do so. The interface information necessary to achieve interoperability of
the Software with independently created computer programs will be provided by
Kaspersky Lab on request on payment of its reasonable costs and expenses for
procuring and supplying such information. In the event Kaspersky Lab notifies
you that it does not intend to make such information available for any reason,
including (without limitation) costs, you shall be permitted to take such steps to
achieve interoperability provided that you may only reverse engineer or
decompile to the extent permitted by law.

1.1.4  You shall not, nor permit any third party to copy (other than as expressly
permitted herein), make error corrections to or otherwise modify, adapt or
translate the Software nor create derivative works of the Software.

1.1.5  You shall not rent, lease or lend the Software to any other person, nor
transfer or sub-licence your licence rights to any other person.

1.2 Server-Mode Use. You may use the Software on a Client Device or on
or as a server (“Server”) within a multi-user or networked environment (“Server-
Mode”) only if such use is permitted in the applicable price list or product
packaging for the Software. A separate licence is required for each Client
Device or “seat” that may connect to the Server at any time, regardless of
whether such licenced Client Devices or seats are concurrently connected to or
actually accessing or using the Software. Use of software or hardware that
reduces the number of Client Devices or seats directly accessing or utilizing the
Software (e.g., “multiplexing” or “pooling” software or hardware) does not reduce
the number of licences required (i.e., the required number of licences would
equal the number of distinct inputs to the multiplexing or pooling software or
hardware “front end”). If the number of Client Devices or seats that can connect
to the Software can exceed the number of licences you have obtained, then you
much have a reasonable mechanism in place to ensure that your use of the
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Software does not exceed the use limits specified for the licence you have
obtained. This licence authorises you to make or download such copies of the
Documentation for each Client Device or seat that is licensed as are necessary
for its lawful use, provided that each such copy contains all of the Documentation
proprietary notices.

1.3 Volume Licences. If the Software is licensed with volume licence terms
specified in the applicable product invoicing or packaging for the Software, you
may make, use or install as many additional copies of the Software on the
number of Client Devices as the volume licence terms specify. You must have
reasonable mechanisms in place to ensure that the number of Client Devices on
which the Software has been installed does not exceed the number of licences
you have obtained. This licence authorizes you to make or download one copy
of the Documentation for each additional copy authorized by the volume licence,
provided that each such copy contains all of the Document’s proprietary notices.

2. Term. This Agreement is effective for the period specified in the Key
File (the unique file which is required to fully enable the Software, please see
Help/ about Software or Software about, for Unix/Linux version of the Software
see the notification about expiration date of the Key File) unless and until earlier
terminated as set forth herein. This Agreement will terminate automatically if you
fail to comply with any of the conditions, limitations or other requirements
described herein. Upon any termination or expiration of this Agreement, you
must immediately destroy all copies of the Software and the Documentation.
You may terminate this Agreement at any point by destroying all copies of the
Software and the Documentation.

3. Support.
(i) Kaspersky Lab will provide you with the support services (“Support
Services”) as defined below for a period of one year on:

(a) payment of its then current support charge; and

(b) successful completion of the Support Services Subscription

Form as provided to you with this Agreement or as available on the
Kaspersky Lab website, which will require you to produce the Key
Identification File which will have been provided to you by Kaspersky
Lab with this Agreement. It shall be in the absolute discretion of
Kaspersky Lab whether or not you have satisfied this condition for the
provision of Support Services.

(ii) Support Services will terminate unless renewed annually by payment of
the then current annual support charge and by successful completion of the
Support Services Subscription Form again.

(iii) By completion of the Support Services Subscription Form you consent
to the terms of the Kaspersky Lab Privacy Policy which is attached to this
Agreement, and you explicitly consent to the transfer of data to other countries
outside your own as set out in the Privacy Policy.
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(iv) “Support Services” means
(a) Daily updates of antivirus databases;
(b) Free software updates, including version upgrades;
(c) Extended technical support via E-mail and hot phone-line
provided by Vendor and/or Reseller;
(d) Virus detection and curing updates in 24-hours period.
4. Ownership Rights. The Software is protected by copyright laws.

Kaspersky Lab and its suppliers own and retain all right, title and interest in and
to the Software, including all copyrights, patents, trademarks and other
intellectual property rights therein. Your possession, installation, or use of the
Software does not transfer to you any title to the intellectual property in the
Software, and you will not acquire any rights to the Software except as expressly
set forth in this Agreement.

5. Confidentiality. You agree that the Software and the Documentation,
including the specific design and structure of individual programs and the Key
Identification File constitute confidential proprietary information of Kaspersky
Lab. You shall not disclose, provide or otherwise make available such
confidential information in any form to any third party without the prior written
consent of Kaspersky Lab. You shall implement reasonable security measures
to protect such confidential information, but without limitation to the foregoing
shall use best endeavours to maintain the security of the Key Identification File.

6. Limited Warranty

(i) Kaspersky Lab warrants that for [90] days from first download or
installation the Software will perform substantially in accordance with the
functionality described in the Documentation when operated properly and in the
manner specified in the Documentation.

(ii) You accept all responsibility for the selection of this Software to meet
your requirements. Kaspersky Lab does not warrant that the Software and/or the
Documentation will be suitable for such requirements nor that any use will be
uninterrupted and error free;

(iii) Kaspersky Lab does not warrant that this Software identifies all known
viruses, nor that the Software will not occasionally erroneously report a virus in a
title not infected by that virus;

(iv) Your sole remedy and the entire liability of Kaspersky Lab for breach of
the warranty at paragraph (i) will be at Kaspersky Lab option, to repair, replace or
refund of the Software if reported to Kaspersky Lab or its designee during the
warranty period. You shall provide all information as may be reasonably
necessary to assist the Supplier in resolving the defective item;
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(v) The warranty in (i) shall not apply if you (a) make or cause to be made
any modifications to this Software without the consent of Kaspersky Lab, (b) use
the Software in a manner for which it was not intended or (c) use the Software
other than as permitted under this Agreement;

(vi) The warranties and conditions stated in this Agreement are in lieu of all
other conditions, warranties or other terms concerning the supply or purported
supply of, failure to supply or delay in supplying the Software or the
Documentation which might but for this paragraph (v) have effect between the
Kaspersky Lab and your or would otherwise be implied into or incorporated into
this Agreement or any collateral contract, whether by statute, common law or
otherwise, all of which are hereby excluded (including, without limitation, the
implied conditions, warranties or other terms as to satisfactory quality, fitness for
purpose or as to the use of reasonable skill and care).

7. Limitation of Liability

(i) Nothing in this Agreement shall exclude or limit Kaspersky Lab’ liability
for (i) the tort of deceit, (ii) death or personal injury caused by its breach of a
common law duty of care or any negligent breach of a term of this Agreement,
(iii) any breach of the obligations implied by s.12 Sale of Goods Act 1979 or s.2
Supply of Goods and Services Act 1982 or (iv) any liability which cannot be
excluded by law.

(i) Subject to paragraph (i), the Supplier shall have no liability (whether in
contract, tort, restitution or otherwise) for any of the following losses or damage
(whether such losses or damage were foreseen, foreseeable, known or
otherwise):

(a) Loss of revenue;

(b) Loss of actual or anticipated profits (including for loss of profits
on contracts);

(c) Loss of the use of money;

(d) Loss of anticipated savings;

(e) Loss of business;

() Loss of opportunity;

(9) Loss of goodwill;

(h) Loss of reputation;

(i) Loss of, damage to or corruption of data; or

@) Any indirect or consequential loss or damage howsoever

caused (including, for the avoidance of doubt, where such loss or
damage is of the type specified in paragraph (ii), (a) to (ii), (i).
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(iii) Subject to paragraph (i), the Kaspersky Lab liability (whether in contract,
tort, restitution or otherwise) arising out of or in connection with the supply of the
Software shall in no circumstances exceed a sum equal to the amount equally
paid by you for the Software.

8. The construction and interpretation of this Agreement shall be governed
in accordance with the laws of England and Wales. The parties hereby submit to
the jurisdiction of the courts of England and Wales save that Kaspersky Lab as
claimant shall be entitled to initiate proceedings in any court of competent
jurisdiction.

9. (i) This Agreement contains the entire understanding of the
parties with respect to the subject matter hereof and supersedes all and any prior
understandings, undertakings and promises between you and Kaspersky Lab,
whether oral or in writing, which have been given or may be implied from
anything written or said in negotiations between us or our representatives prior to
this Agreement and all prior agreements between the parties relating to the
matters aforesaid shall cease to have effect as from the Effective Date. Save as
provided in paragraphs (ii) - (i), you shall not have any remedy in respect of an
untrue statement made to you upon which you relied in entering into this
Agreement (“Misrepresentation”) and Kaspersky Lab shall not have any liability
to the other than pursuant to the express terms of this Agreement.

(ii) Nothing in this Agreement shall exclude or limit Kaspersky Lab’ liability
for any Misrepresentation made by it knowing that it was untrue.

(iii) The liability of Kaspersky Lab for Misrepresentation as to a fundamental
matter, including a matter fundamental to the maker's ability to perform its
obligations under this Agreement, shall be subject to the limitation of liability set
out in paragraph 7(iii).
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